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Before you begin

This Learner Guide is based on the unit of competency BSBTEC302 Design and produce 

spreadsheets, Release 1. Your trainer or training organisation must give you information 

about this unit of competency as part of your training program. You can access the unit 

of competency and assessment requirements at:  

www.training.gov.au.

How to work through this Learner Guide

This Learner Guide contains a number of features that will assist you in your learning. 

Your trainer will advise which parts of the Learner Guide you need to read, and which 

Practice Tasks and Learning Checkpoints you need to complete. The features of this 

Learner Guide are detailed in the following table.

Feature of the 
Learner Guide

How you can use each feature 

Learning content Read each topic in this Learner Guide. If you come across content that is 

confusing, make a note and discuss it with your trainer. Your trainer is in the 

best position to o$er assistance. It is very important that you take on some 

of the responsibility for the learning you will undertake.

Examples These highlight key learning points and provide realistic examples of 

workplace situations.

Practice Tasks Practice Tasks give you the opportunity to put your skills and knowledge 

into action. Your trainer will tell you which practice tasks to complete.

Summaries Key learning points are provided at the end of each topic.

Learning 

Checkpoints

There is a Learning Checkpoint at the end of each topic. Your trainer will tell 

you which Learning Checkpoints to complete. These checkpoints give you 

an opportunity to check your progress and apply the skills and knowledge 

you have learnt.
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Before you begin

Foundation skills

As you complete learning using this guide, you will be developing the foundation skills 

relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN) 

skills and the employability skills required for participation in modern workplaces and 

contemporary life.

The following table provides de+nitions for each foundation skill. 

Foundation skill area Foundation skill description

Reading  • Recognises and interprets numerical and textual information 

to determine organisational and task requirements

Writing  • Inputs numerical and key reporting information when 

creating and finalising spreadsheets and uses format, layout, 

style guides and standard naming conventions to organise 

data according to purpose and audience

Numeracy  • Uses mathematical equations to create simple formulae and 

validate numerical data

Teamwork  • Collaborates with others to achieve joint outcomes

Technology  • Uses advanced features within relevant digital applications 

to address routine and complex work tasks
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What do you already know?

Use the following table to identify what you may already know. This may assist you to 

work out what to focus on in your learning.

Topic Key outcome Rate your confidence 
in each section

Topic 1: Prepare to use 

spreadsheets

1A Using safe and e$icient work 

practices
 Confident

 Basic understanding

 Not confident

1B Identifying task requirements and 

selecting the best application
 Confident

 Basic understanding

 Not confident

Topic 2: Design and create 

spreadsheets

2A Entering data and formatting cells  Confident

 Basic understanding

 Not confident

2B Using and testing formulas and 

functions
 Confident

 Basic understanding

 Not confident

Topic 3: Produce charts 3A Selecting an appropriate chart type 

and design
 Confident

 Basic understanding

 Not confident

3B Creating and modifying charts  Confident

 Basic understanding

 Not confident

Topic 4: Finalise and 

present spreadsheets

4A Finalising and reviewing 

spreadsheets
 Confident

 Basic understanding

 Not confident

4B Printing spreadsheets  Confident

 Basic understanding

 Not confident

4C Naming and storing spreadsheets 

appropriately
 Confident

 Basic understanding

 Not confident
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Topic 1 | Prepare to use spreadsheets

1A Using safe and e$icient work practices

1B Identifying task requirements and selecting the best application 
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1A Using safe and e2icient work practices 

Workplace safety is everyone’s responsibility. 

Both employers and employees must make an active contribution to ensuring their 

workplace is safe. They need to identify hazards and assess risks to reduce the risk of 

injury in the workplace. 

If you are working at a computer for an extended period of time each day, your 

workstation must be comfortable and designed to help you carry out your tasks 

e2ciently. You will need to organise your work so that you are not doing a repetitive task 

for a long time. You should also take regular breaks to stand up and stretch. 

To increase e2ciency, you can also use sustainability techniques to prevent wastage. 

Most organisations require sta4 to follow sustainability procedures such as recycling 

paper and turning o4 lights in unused rooms. You need to be aware of any conservation 

e4orts made by your organisation.

Health and safety policies and procedures are documents that ensure all employees work 

safely and e4ectively. 

All workplaces in Australia are required to have a health and safety policy in place that 

describes the organisation’s responsibility and employees’ responsibility for maintaining 

health and safety. The policy should include the organisation’s goals and objectives 

regarding health and safety and can help you ful+l your duty of care as an employee.

The following information relates to working in an o2ce and using a computer 

workstation and should be contained in an organisation’s health and safety procedures.

Health and safety procedures outline:

• workstation ergonomics

• standard safety precautions and housekeeping

• safe handling of hazardous substances, e.g. cleaning products

• emergency and fire drills

• hazard identification and risk control

• manual handling

• emergency contact numbers, including local doctors and hospitals

• location of first-aid equipment 

• details of first-aid o$icers.
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Musculoskeletal disorders 

Gradual wear and tear or sudden damage can cause musculoskeletal disorders.

The repetitive movements and sustained body position associated with entering data 

into a computer is regarded as a hazardous manual task and puts the operator at risk of 

developing a musculoskeletal disorder, or MSD. MSDs are caused in two main ways:

• gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs 

through repeated or continuous use of the same body parts, including static body 

positions

• sudden damage caused by strenuous activity or unexpected movements, such as 

when loads being handled move or change position suddenly.

MSDs may include conditions such as: 

• sprains and strains of muscles, ligaments and tendons

• back injuries, including damage to the muscles, tendons, ligaments, spinal discs, nerves, 

joints and bones

• joint and bone injuries or degeneration, including injuries to the shoulder, elbow, wrist, hip, 

knee, ankle, hands and feet

• nerve injuries or compression, e.g. carpal tunnel syndrome

• muscular and vascular disorders as a result of hand–arm vibration

• soft tissue hernias

• chronic pain.

Standard precautions

Your organisation may require you to use standard precautions, particularly work 

practices related to the prevention of repetitive strain injuries (RSIs). 

These include ergonomic practices, workstation design, enforced breaks and regular 

exercise routines. A workstation includes a computer, monitor, keyboard, mouse, desk 

and chair.

Workers in an o2ce are expected to follow standard precautions when using a 

workstation, particularly at a sit-down desk. Research on sitting has demonstrated that 

other precautions also need to be considered, such as the use of standing workstations, 

to ensure that injuries are prevented. It is important that you carefully follow any 

standard precautions that are prescribed for your workplace.
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Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and 

equipment you use during the day to make sure they are in good working order. 

Your organisational policies and procedures should include steps to follow. You may 

need to perform this procedure at the start of your work day or at speci+ed intervals 

throughout the day.

Workstation safety procedure/checklist:

 � Ensure your seat is positioned in front of your computer and that you can reach your 

keyboard comfortably.

 � Position the monitor out of direct sunlight and at the correct height. 

 � Ensure the environment is dust-free as dust can a$ect the monitor or the computer’s central 

processing unit (CPU).

 � Ensure cables are secured so no one trips over them.

 � Use blinds and window coverings to reduce glare and heat at your workstation.

 � Ensure temperatures do not exceed 26°C and that humidity is between 40 and 60 per cent.

Ergonomics

The aim of ergonomics is to reduce the risk of accidents, injury and illness by 

applying safe work practices. 

Ergonomics is about creating comfortable working conditions by adapting workstations, 

tools and equipment to an individual worker’s needs. It also improves performance and 

productivity in the workplace. Ergonomics covers all aspects of working, from physical 

stresses such as sitting at a workstation all day, to environmental factors such as noise, 

air conditioning and lighting.

When your posture is poor, you may su4er from aches and pains. Spending a long time 

in the same position can put stress on your body and this can be made worse if you are 

in an uncomfortable or poorly supported position. These symptoms may be very slight at 

+rst, but if you continue to have poor posture your symptoms may get worse and become 

intolerable. They may result in cumulative stress, given the constant strain on your 

muscles, nerves or tendons. 

When setting up your workstation, make sure your posture will not cause you pain or 

discomfort. The equipment you use needs to be adjusted to suit your body shape and 

size, and the tasks you are doing.
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Ergonomic workstation design

Ergonomic workstation design can reduce the risk of health issues or injury in the 

workplace.

Several physical problems can result from poor workstation design; for example, lower back 

strain may result from sitting in a chair that does not support your back. Some features of 

the workstation may vary depending on the type of computer work being performed. 

Below are some guidelines for setting up an ergonomic workstation. 

Chair

• Adjust the seat height to suit your furniture and equipment. Ensure that your 

feet are flat on the floor, your thighs are horizontal and your lower legs are 

vertical. If possible, use a chair with a five-castor base.

• Adjust the backrest by raising it to the maximum height and then lowering 

it until it fits the curve of your lower back. If this is not comfortable, lower it 

another couple of centimetres. Continue this until it reaches a comfortable 

position. 

• The backrest should support your lower back and may also be adjusted 

backwards and forwards. When seated in your usual working position, move 

the backrest until it has a gentle pressure on your lower back. Make sure 

there is at least two centimetres of space between the front of the seat and 

the back of your knees. Armrests should be positioned so that they do not 

interfere with carrying out your work tasks.

Desk

• Keep your head erect when seated at your desk, and ensure that the 

surface of the desk is just below elbow height. 

• If your desk is not height-adjustable, try to raise your chair so you are 

sitting at the correct height, and use a footrest, if necessary, to make up the 

di$erence. Ensure there is clearance between the lower edge of the desk 

and your legs, and between the front edge of your seat and your desk.

• If your desk is too low, you may be able to extend the legs. You should have 

plenty of leg space underneath your desk. Do not clutter the space with 

bags and bins, as your legs may become cramped and your posture may 

become twisted. 

• Position any equipment or materials you use so that you can reach them 

easily without twisting. For example, place frequently used stationery in the 

top desk drawer, and ensure your keyboard and monitor sit directly in front 

of you to avoid having to twist your body.
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Keyboard

• The angle of your keyboard can be adjusted to suit you by moving the 

supports underneath it. Place the keyboard as close as possible to the front 

of your desk. Have your upper arms hanging freely. Your forearms should be 

approximately horizontal.

• While typing it is best not to rest your wrists, as they should not be bent 

up, down or to the side. The knuckle, wrist and top of the forearm should 

form a straight line. Wrist supports give you a place to rest your hands only 

when pausing from typing, not while you are typing. Do not pound the 

keys; instead, use a light touch. Leave enough room on your desk to put the 

keyboard out of the way when you are not using it.

• Do not place documents between yourself and the keyboard, as stretching 

will eventually cause muscle strain in your arms, shoulders and neck. 

Mouse

• Place the mouse and mouse pad directly beside your keyboard on the side 

you prefer. If you use the mouse frequently, you could try to alternate sides. 

You will be surprised at how easy this becomes with practice. Your wrist 

should be straight and the desk should support the weight of your wrist, 

not your arm. Try to keep your wrist flat and rest your fingers on the mouse 

between clicks. Hold the mouse lightly. Do not hold onto the mouse when 

you are not using it.

Monitor

• Once you have adjusted your chair and desk, you can position your monitor. 

Adjust it so that the top of the monitor is level with or slightly lower than 

your eyes. If you cannot adjust the monitor to the correct height, place it on 

a platform.

• The viewing distance should be between 40cm and 70cm. The screen angle 

should be adjustable between 85 and 125 degrees. It is best to position the 

screen so that you can clearly read the text without having to lean forward, 

twist your neck or look upwards. A relaxed viewing angle is approximately 

35 degrees. Place a document holder beneath or beside the monitor at the 

same viewing distance as the screen.

• When positioning your screen, take surrounding factors such as reflection, 

glare and shadow into consideration. You may need to use an anti-glare filter.
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Desktop layout

Items on your desk, including equipment and resources, should be arranged so they are 

in easy reach.

Your desk area can be divided into three zones:

• the optimum reach zone – the area closest to you, where your hands operate most 

of the time

• the maximum reach zone – items are further away, but still close enough to reach 

comfortably

• the outer reach zone – where you may have to bend forward or stand to 

reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard, 

are close to you. Objects that are used less frequently, such as your phone, should be out 

of the way but still within easy reach. Other resources that are rarely used, such as in- 

and out-trays, should be in the outer reach zone.

The following outlines some devices that can help you maintain a good posture at your 

workstation.

Document holders

Document holders are designed to hold papers and reference material in a 

convenient position for viewing. Place your document holder in the correct 

position. If it is below the screen or too far o$ to the side, each time your eyes 

look from one source to the other, your pupils have to adjust. Doing this for long 

periods of time can cause headaches and eyestrain. Place the document holder 

at a similar level, angle and distance as the screen to avoid having to shift your 

eye focus.

Angle boards

Angle boards allow the user to maintain the correct posture when reading by 

reducing the angle between the work surface and the user. These supports 

can be adjusted to a suitable height and angle, and enable comfortable reading 

with the neck correctly positioned. Try to keep your neck as straight as possible 

when you are reading.
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Footrests

A footrest may be necessary if you cannot place your feet comfortably on the 

floor. Footrests allow your feet to rest at the correct height and on a tilting 

angle, which prevents strain on the lower back. 

Headsets

If you use a telephone for long periods of time, it is a good idea to use a 

headset. A headset will keep your neck straight and your arms free. Headsets 

prevent you from bending your neck to support the telephone handpiece.

Benefits of using standing desks

Sitting at a desk for long periods of time has many negative health e4ects. 

These can be overcome by using standing desks. Standing provides a greater opportunity 

for your body to move and adjust, and involves more muscular activity than sitting. 

Some studies have shown that the negative e4ects of prolonged sitting cannot be 

counteracted by regular exercise. The only way to eliminate the problem is to avoid 

sitting as much as possible. 

Some of the health bene+ts of standing include:

• alleviating back pain and other repetitive strain injuries by greater use of core 

back muscles to support the upper body

• increasing focus, alertness and activity level by releasing restless energy

• reducing the risk of developing cardiovascular disease, diabetes and blood clots, 

which can be caused by prolonged sitting.

It is recommended that you start using a standing desk gradually by alternating between 

sitting and standing. Using a standing desk for hours on end requires your body to adapt. 

You may experience sore feet, tired legs and fatigue at +rst. Wear comfortable shoes and 

use an anti-fatigue @oor mat to help counteract this.

Ensure you have an ergonomically designed standing desk so that you maintain correct 

posture while working. 
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Standing desk recommendations

• Position arms at 90 degrees when standing.

• Place the computer screen at eye level and tilt it slightly upwards.

• Place the computer monitor at least at arm’s length away.

• Keep your back straight and avoid leaning on the desk.

Vary your activities

Make sure you plan your daily tasks so that you are not doing repetitive work for long 

periods of time.

Having a well-planned workstation and comfortable surrounding is pointless if you do 

not organise your work in a way that prevents discomfort or pain. 

Your work role may involve several di4erent tasks. Some tasks may be repetitive, such 

as typing up reports or entering data. If you are able to vary the tasks you carry out 

each day, this will help to prevent repetitive actions that cause stress to your body. For 

example, if you have to enter a lot of data, break up the repetitive nature of the task 

by discussing a project with a colleague, doing some research online or doing another 

work task. 

You should also take regular breaks. Employers are required to allow employees to take 

rest periods throughout the day, including tea breaks and lunch breaks, to reduce stress 

and fatigue.

Take exercise breaks

Using computers for too long without breaks has been associated with back and neck 

pain, headaches, migraines and eyestrain.

Try the following exercises several times a day, and encourage your colleagues to try 

them, too. Make sure you are relaxed and stretch gently, without overstretching. Stop if 

you feel any pain or discomfort, and remember to exercise both sides of your body. Most 

importantly, breathe deeply and evenly throughout the stretch.
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• Neck: Turn your head gently to look over your right shoulder. Hold for 10 seconds. Now roll 

your head forward to look over your left shoulder and hold for 10 seconds. Repeat several 

times.

• Shoulders: Sitting with a straight back and neck, roll your shoulders forward, then back. 

Repeat several times.

• Wrists, hands and arms: Interlacing fingers, turn your palms upwards. Now lift your 

arms over your head and stretch, leaning gently to the left and then to the right. Repeat 

movement several times.

• Upper and lower back: In a standing position, place your hands in the small of your back. 

Gently arch your back and hold for 10 seconds. Repeat when needed.

• Shoulders and arms: Stretch your arms above your head, cradle your elbow with your hand 

and gently pull your elbow behind your head. Repeat on the other side, holding the stretch 

for 10 seconds.

• Eyes: Every 20 minutes, look away from the screen. Focus on a distant object (more than 

three metres away).

Practise conservation techniques

Conserving resources at work not only bene+ts the organisation by reducing costs, but 

also bene+ts the planet by reducing greenhouse gases and the amount of waste sent to 

land+ll. 

Most organisations have policies and procedures for conserving resources. You can +nd 

out what these are by reading your workplace manual, or by asking your manager or 

colleagues.

The following outlines ways to conserve resources at work.

Minimise paper wastage

 └ Policies for reducing paper wastage include:

• using both sides of the paper when printing and photocopying

• recycling non-confidential waste paper 

• reducing the volume of printing where possible

• reusing paper by using blank sides for rough drafts 

• using recycled paper or paper from plantation timber for printed documents.
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Reduce energy use

 └ Policies and procedures for saving energy include:

• providing training programs on smart energy practices so that employees can 

practise energy e$iciency

• turning o$ lights and equipment when not in use

• keeping air conditioners at 18–20°C in winter and 24–27°C in summer

• using power-saving functions on devices such as computers and tablets.

Practice Task 1

Question 1

Here is a checklist to follow when setting up your workstation. Go through the points that are 

relevant to you and make any necessary adjustments to your work area. You may need another 

person to help you and check your posture. If you are not able to tick some of the checkpoints, 

discuss making alterations to your workstation with your manager.

Chair

 � Is the seat height-adjustable?

 � Is it high enough to allow you to sit comfortably at the keyboard?

 � Is it stable?

 � Does it swivel?

 � Is the height of the backrest adjustable and does it tilt backwards and forwards?

 � If it has arms, can you still get close enough to the desk and swivel the chair?

 � Are your feet flat on the floor or are you using a footrest?

 � Are you sitting up straight with the backrest firm against your back?

Desk

 � Is it large enough to allow the screen and keyboard to be correctly positioned?

 � Is it low enough to allow you to keep your forearms horizontal or sloping downwards?

 � Is it high enough to allow your thighs to fit comfortably underneath?

Keyboard

 � Can it be tilted to allow you to adjust it?

 � Are the symbols on the keys clear and easy to see?

 � Is there su$icient space in front of it to allow you to correctly position your arms?
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Monitor

 � Does the monitor have easily adjustable brightness and contrast controls?

 � Is the image on the monitor stable and flicker-free?

 � Are there adjustment mechanisms to allow the monitor to be tilted, swivelled or raised 

to avoid glare and reflections, and help you keep a natural and relaxed posture?

 � Are you sitting far away enough from it for comfort?

Question 2

Describe the possible consequences for an organisation in which employees do not consider 

their physical health.

Question 3

What should a Work Health and Safety (WHS) policy include?
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Question 4

What should WHS procedures include?

Question 5

Why should you vary the tasks you carry out each day?

Question 6

Read the following statements about sustainability in the workplace and decide whether they 

are true or false.

a) Screen savers help to save energy.  » True  » False

b) Turning o$ a computer crashes the hard drive.  » True  » False

c) Refilled toner or ink cartridges leak everywhere and make  

a huge mess.
 » True  » False

d) Putting computers into sleep mode when they are inactive  

helps to save energy.
 » True  » False

e) Printing and filing all documents in hard copy does put a  

high demand on resource consumption.
 » True  » False
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1B Identifying task requirements and selecting 
the best application

All organisations need to manage and store numerical data, and a spreadsheet 

is the most appropriate tool for doing this.

Organisations use spreadsheets to store and calculate numerical data, which can then 

be used to produce such things as charts, graphs, statements and reports. In accounting, 

a spreadsheet is a large sheet that displays a company’s +nancial position. It shows all 

+nancial information, such as costs, income and taxes on a single sheet. This is useful for 

a manager to look at when making a decision. 

An electronic spreadsheet organises information into columns and rows. The data can 

then be manipulated by a formula to provide a sum total. The spreadsheet can present 

the information in a format to help a decision-maker see the +nancial big picture of an 

organisation.

You also need to know the location and procedure for the electronic +ling system for 

storing spreadsheets. This is a normal part of using any computer application and it is 

part of workplace protocol. It is important to ensure you store your spreadsheet for easy 

access by you and your colleagues. 

Many organisations have speci+c requirements about how data is stored and the way 

it is displayed and presented. Organisations often have a style guide that outlines the 

speci+cations and design requirements, such as use of headings, particular colours, 

borders and shading, columns and rows. 

You must be aware of these requirements so your spreadsheet meets your organisation’s 

standards. These requirements can relate to how the data is entered, stored, presented 

and produced. These usually have to be completed in a designated timeline to meet a 

deadline. 

Use instructions on organisational and task requirements to check that the job has been 

completed correctly.
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Identify purpose and audience 

When planning your spreadsheet, it is important to know what it is going to be 

used for and who is going to use it.

Spreadsheets are created for many reasons, including:

• accounting and calculations

• tracking spending

• budgeting

• assisting with data exports from one system to another

• creating quotes, receipts and invoices

• generating reports and charts.

The purpose of a spreadsheet varies and will in@uence the type of document you produce 

and the data you use to populate the spreadsheet. Clarify the purpose of the spreadsheet 

before you begin to determine the way it is planned and designed. For example, if the 

document’s purpose is to provide numerical data on sales +gures, you may have to collect 

the information and collate this into the spreadsheet.

Intended audience

Before you design the spreadsheet, you need to be aware of your document’s audience. 

Keep in mind who it is intended for and decide how you should present the information. 

The document’s audience will a4ect how the information is presented. Consider the 

information needs of the audience and how detailed the information should be.  

A detailed document is likely to have many columns and rows, or may extend over 

several sheets.

You may want to consider the following questions:

• Who will be using the spreadsheet? 

• Are they familiar with using spreadsheet applications? 

• Do they need to collaborate online? 

• Are they required to enter data or just review the information? 
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Identify task requirements

Ensure you understand all the requirements of the task before you begin. You know what 

the spreadsheet is going to be used for and who is going to use it, but you also need to 

+nd out the following:

• Is data entry required or is the data already available?

• Where is the data stored and where should the spreadsheet be saved?

• When does the task need to be completed?

• Does any of the data need to be represented as graphs or charts?

• Are printouts or electronic copies required?

The answers to these questions will help you prepare for designing your spreadsheet.

Storage and output 

Once you have entered data into your worksheet, you need to know what the required 

output is, how it should be presented and where it should be stored. 

Your manager may need you to enter monthly sales +gures and provide a total amount. 

In this case you need to add a column labelled ‘Total’. You may need to format your 

spreadsheet to match organisational requirements; for example, you may need to use 

a certain font type and size for labels, and include precise information in the header 

and footer.

Where you store your spreadsheet depends on who needs the information. When you 

create a spreadsheet, you need to save it immediately. You can save it to your personal 

hard drive or to a shared drive on your organisation’s server. A server delivers information 

to other computers linked by a network. Ask your manager where you should save your 

spreadsheet to ensure you are adhering to company protocols. 

When you start a new spreadsheet, you should think about how you want the 

spreadsheet to present the results, or output, of its calculations. 

Some points about output to keep in mind include:

• Who is going to use the results?

• What are the results that will be useful to them?

• How are they going to use them?

• What format will they want them in? 

• What labels should you put on any number results so people can understand what they are? 

• Is the output going to be printed, stored or sent to someone electronically?
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Determine and meet timelines

Whenever you are given a work task, you need to determine a timeline for its 

completion. 

A timeline is a plan for how long a task will take to complete. It also breaks the task 

into steps, and states when each step needs to be completed. Using a diary system and 

a to-do list can help you prioritise tasks and keep on top of the timelines required for 

set tasks.

In many cases, timelines are set and agreed with your stakeholders – both internal and 

external. Internal stakeholders work in the same organisation as you, and may include 

colleagues in other departments, managers and supervisors. External stakeholders, 

including customers and suppliers, are outside of the organisation. 

Often your manager or supervisor will give you a deadline for completing a task, such 

as ‘prepare a spreadsheet by 2pm’. Alternatively, you may have deadlines for completing 

regular work tasks, such as completing a monthly sales report or a summary of customer 

contact details. 

Meeting a deadline demonstrates your competency in undertaking tasks, as well as 

showing your professionalism. Make sure that when deadlines are set, they are both 

achievable and realistic.

If you have concerns that a deadline might not be met or you have con@icting priorities, 

discuss this with your manager or supervisor as soon as possible. They may be able to 

assist you by suggesting how the deadline can be met or agreeing to adjust the timeline 

for the task.

Presentation requirements

Every organisation has di#erent requirements for business documents. 

How you present your spreadsheet will enhance the audience’s ability to understand it. 

You need to check if there is a template for the task, such as a template for a presentation, 

handout or report. Think about the use of colour, columns and rows, logos and 

formatting requirements.

There are often guidelines or instructions for producing a spreadsheet, which help to 

communicate an organisation’s professionalism to those outside of it. These may relate to 

the content of the spreadsheet or its format and layout. 

One important requirement may be to present an appropriate and consistent corporate 

image by using the organisation’s logo, colour scheme and house style.
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Most organisations outline document production procedures and guidelines either in 

their policies and procedures manual or in an in-house style guide. Make sure you know 

where these instructions are kept and that you are familiar with them.

The requirements appropriate for one organisation may not suit another; for example, a 

law +rm’s requirements would be di4erent from that of a sports equipment retailer. 

You may be asked to prepare a report about stock on hand and to arrange the data in 

product code order, highlighting the quantity on hand and the quantity on order. You 

may also be asked to cross-check product codes with the product description.

Clarify the use of house styles for your organisation with your supervisor and colleagues, 

and ask what the requirements are for the job you are going to undertake before you 

begin. If you have your own ideas on how the content or format of a spreadsheet could be 

improved, speak to your supervisor.

To prepare appropriate documents for your organisation, you must follow established 

guidelines and procedures for production.

Established guidelines and production procedures may include:

• monitoring the designated timeline 

• adhering to content restrictions

• using templates

• including the organisation’s name, time, date and file name in the header and footer

• observing copyright legislation

• delivering the content in the required format.
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Practice Task 2

Part A

Question 1

Explain why it is important that you find out information from your supervisor in relation to the 

following before you begin a task:

a) The purpose of the spreadsheet

b) The intended audience

Question 2

What can you do to ensure the presentation requirements, such as layout and design of the 

spreadsheet, meet the professional and corporate image of an organisation? 
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Part B
Read the case study, then answer the questions that follow.

Case study

Phuong works as an administrative o$icer for a local council. She has recently moved into the 

community development department from the rates department and is looking forward to the 

change. Phuong has been asked by her supervisor to create a spreadsheet report summarising the 

number and type of small businesses in the area, and to include a chart that shows the clustered 

locations of the businesses. Phuong is familiar with using spreadsheets and creating charts from 

her time in the rates department. However, she is not sure how to find the information to include in 

the report – does it mean that she has to go out and visit all the small businesses in the area? 

Phuong decides to speak with her supervisor to clarify what is required to produce the report. 

Phuong’s supervisor explains that it is a report which is completed on an annual basis, so she 

should be able to access last year’s report from the network drive. However, her supervisor is 

not sure of the spreadsheet name, so she will need to a look for it. Her supervisor suggests that 

she follows the same layout and presentation as last year’s report, although she should check 

that it has the current council logo in the heading. Phuong asks her supervisor who the report is 

for to check output requirements. Her supervisor explains it is to be presented at the upcoming 

management meeting next Friday. Her supervisor has asked that she complete a draft of the 

spreadsheet by Wednesday morning so that he can check the report. Once checked, 15 copies of 

the report need to be produced.

Phuong goes back to her desk and locates last year’s report. She now knows how it should look. 

She also knows her deadline, the reason for producing the report and how many copies are 

required. She obtains data from another report that was produced by her co-worker last month. 

Phuong is able to use this report as her source document for creating the report she has been 

asked to complete.

Question 1

What is Phuong’s task?
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Question 2

What does Phuong do to clarify task requirements?

Question 3

What additional sources of information were helpful to Phuong in producing the report?
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Selecting a suitable spreadsheet application

Before creating a spreadsheet, you should consider which application to use. 

Sometimes you will be able to choose, other times you will have to use the 

software provided by your organisation.

Spreadsheet applications o4er similar features:

• workbooks and sheets (pages in the document) are made up of columns and rows

• text, numbers and formulas are entered into cells

• formatting tools provide di4erent options for presenting data

• +les can be saved and opened in di4erent +le formats (CSV, XLS, XLSX, PDF)

• graphs and charts can be created to help visualise information.

Some spreadsheet programs can be downloaded or accessed free from the internet, others 

require you to pay a subscription fee. Many are available as o4-the-shelf software packages.

Some of these applications can be shared and worked on by multiple users at once and 

accessed online. This is known as cloud computing. 

The most commonly used spreadsheet software is Microsoft Excel, although some 

organisations prefer to use other programs.

The examples given in this learner guide are based on Excel 2016. Earlier versions will be 

similar in how they work, although there may be some di4erences in the appearance of 

the screens.

The following table outlines some of the key features of each.

Spreadsheet software Key features

Microsoft Excel • Calculation tools

• Tools for creating graphs and charts

• Tools to hide columns, rows and sheets

• Able to access external data sources

• Available as desktop software, online application and mobile app 

• Password protection

• Able to communicate with other Microsoft O$ice programs, 

including Word and Access

Google Sheets • Cloud-based, meaning multiple users are able to work in the 

document at once to collaborate on tasks

• Available as desktop software, online application and mobile app 

• Keeps track of revision history

• Private data is stored on Google servers

• Uses action items to assign a person to a task

• Explore function allows users to search for information online
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Spreadsheet software Key features

Apache OpenO#ice 

Calc

• Able to summarise and convert raw data into meaningful 

information

• Formulas can be created using both numbers and words

• Includes ready-made templates

• Allows users to forecast results, e.g. based on high or low sales 

results

• Allows data from multiple users to be integrated

Smartsheet • Cloud-based, meaning multiple users are able to work in the 

document at once to collaborate on tasks

• Keeps track of timelines, calendars and task requirements

• Rows can be expanded to see more detailed notes

• Each row can have files and emails attached to it and a discussion 

board linked to it

• Contains a calendar view and alerts users of upcoming deadlines

• Can import data from other programs, including Microsoft O$ice 

and Google applications

• Available as desktop software or a mobile app

There are many organisational and reporting requirements, which will be outlined in 

organisational policies and procedures. This information may be used to determine 

the resources available to the company, including the speci+c software they can use. 

Be aware of the spreadsheet software used in your organisation, and ensure you follow 

organisational policies and procedures. 

Practice Task 3

Part A

Question 1

If you need to collaborate on tasks with your colleagues and work in real time, which of the 

following software applications would you choose? Tick all that apply.

Microsoft Excel

Google sheets

Apache OpenO$ice Calc

Smartsheet
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Question 2

List four criteria you might use to decide which spreadsheet application to use. 

Part B
Read the case study, then answer the questions that follow.

Case study

Josh works as an administrative assistant in a large organisation. One of his duties is to create 

spreadsheets to his manager’s specifications. One day Josh is asked to create a spreadsheet 

containing the monthly sales figures of a selection of products the organisation sells. The 

spreadsheet has to calculate the total takings for each product and then work out a 10 per cent 

taxation charge for each amount calculated.

The spreadsheet must be formatted to organisational requirements and then saved to the server in 

the shared folder for sales. Josh’s manager tells him to name the spreadsheet ‘Product Totals’.

As well as entering the monthly sales figures in one column, Josh has to create two more columns 

of information.

Question 1

Describe the information to be held in the two new columns.
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Question 2

How would you label the two new columns?

Question 3

How does Josh have to format the data?

Question 4

What is the name of the spreadsheet and where will it be stored?
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Question 5

Why should Josh speak to his supervisor and confirm the delivery and timeline for the 

development of his spreadsheet? 
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Summary

• Ergonomics is about creating comfortable working conditions. Setting up a 

workstation to suit your physical requirements prevents undue stress and strain.

• Plan daily tasks, rest periods and exercise breaks to prevent repetitive work being 

done for long periods of time.

• Make sure your workstation and working conditions are safe and healthy so you 

can work comfortably and productively.  

• Practise conservation techniques to try to minimise paper wastage and 

energy use.

• Conserving resources at work bene+ts the organisation by reducing costs, and 

helps to reduce the amount of greenhouse gas produced and the amount of waste 

going to land+ll.

• Spreadsheets are made up of worksheets and workbooks. A worksheet is divided 

into columns and rows, and the intersection of a column and row is called a cell.

• You can change the appearance of your spreadsheet to suit your organisation’s 

style and presentation requirements.

• Task requirements are important because they ensure all the documents 

produced are:

 − using the best application for the task

 − consistent in style and layout 

 − presenting a consistent corporate image

 − scoped so a schedule can be designed to meet the timeline.

• You should always clarify the task requirements before producing your document 

to ensure you create a spreadsheet that aligns with its purpose and meets the 

needs of the target audience.
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Learning Checkpoint 1

Prepare to use spreadsheets 

Part A
1. Write your ideas on how you and your colleagues could improve work practices in relation to 

the following:

a) Work health and safety

b) Sustainability in the workplace
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Part B
Read the case study, then answer the questions that follow.

Case study

Selda has recently started work as a marketing assistant with a large car sales business. She 

has been asked to create a draft summary report of all existing customers, the types of cars they 

have purchased and if they are repeat customers. The information is to come from the product 

sales database. This information will be used to select customers for the marketing campaign for 

the newly released family wagon. The report will be used by five members of the marketing team 

and seven sales managers. The marketing manager has asked to see a draft of the spreadsheet 

by the end of the week. The spreadsheet is to be stored on the server in the product folder 

‘PNwagonXXR007’. 

Selda knows she needs to abide by organisational requirements for the design and layout.

1. Explain how Selda would identify the following requirements for the task:

a) The purpose of the spreadsheet

b) The audience for the spreadsheet

c) The data source used for data entry
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d) The information to be reported in the spreadsheet

e) The number of copies of the spreadsheet required

f) Where to store the spreadsheet

g) How to name the spreadsheet
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2. What could Selda do to make sure she meets the deadline for production and delivery of the 

spreadsheet? 

3. State four possible design requirements that Selda may need to consider when preparing the 

spreadsheet.

4. What should Selda do to confirm she is using the correct spreadsheet application for the task?
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2A Entering data and formatting cells

2B Using and testing formulas and functions
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2A Entering data and formatting cells 

Excel treats data di#erently, depending on whether it is text, number or date/

time.

The di4erent types of spreadsheet data include:

• text, such as names, addresses and product information

• dates and times

• +gures such as quantities, prices, sales +gures and interest rates.

Dates and times

Dates can be entered in the following formats:

• Day/Month/Year = dd/mm/yyyy

• Month/Day/Year = mm/dd/yyyy

You need to be clear which format is being used. 

Times use am and pm or a 24-hour format. For example, 6.00pm is the same as 

18.00. 

Excel tries to match the formatting with the way the information 

is typed in.

Always confirm the correct formats for your spreadsheet.

To automatically insert the current date into a cell, select the cell and press 

Ctrl+;

To insert the time, press Ctrl+Shift+;

To automatically put the current date in a cell in the worksheet, you can use the 

TODAY function: =TODAY()
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Text

When entering text, you will notice it is automatically 

aligned to the left of the cell. You will also notice that if 

there is no data in the adjacent cell, the text will overflow 

into it.

If there is data in the adjacent cell, the text that is 

entered will be truncated (chopped o$). 

It may appear that the data is lost, but it is still 

contained in the cell. 

A simple way to confirm this is to click in the relevant cell and view the cell’s 

contents in the Formula Bar.

To ensure the printed and on-screen versions  

of the spreadsheet show the cell’s full content,  

you need to adjust the width of the cell or 

wrap text within the cell. 

Text is commonly used for entries of lists of information such as names, 

addresses and product details.

To wrap text in a cell, select the cells and use the Wrap Text tool , 

which is located in the Home tab.

Wrap Text is commonly used for longer entries where you do not want to adjust 

the column width, but want to be able to read all of the information in the cell, 

such as address details.
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Figures

When entering numbers, they will automatically 

 be aligned to the right of the cell. In most cases, if the 

number is longer than the cell, the width of the cell will 

automatically adjust. There is a limit of 15 digits per cell.

Sometimes numbers appear as shown below. 

This occurs when the number has too many 

digits for Excel to include in the cell, so it 

rounds it o$ and puts it in scientific notation.

When the cell is not wide enough for an entry, it is filled with a 

row of hashtags (#). This is a di$erent situation to having too 

many digits.

To correct the problem, adjust the cell width.

You can also use the Number section in the Home 

tab to increase or decrease the number of decimal 

places shown. It is also possible to make number 

formatting choices such as currency.

Formatting spreadsheets 

There are numerous techniques for improving the appearance of spreadsheets. 

Formatting a spreadsheet e4ectively means to present the information in a way that is 

easy to understand. It should also be easy for people to enter data into the spreadsheet.

Before you start planning or designing a spreadsheet, you need to know:

• the purpose of the spreadsheet

• who will use the information

• the type of information that needs to go into the spreadsheet (the inputs)

• the information that the spreadsheet needs to produce (the outputs)

• how to manipulate and process the inputs to produce the outputs. 

Here are some ways that spreadsheets can be formatted.
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Formatting text

The options for formatting text are very similar to those available in word-

processing programs. For example, you can highlight important text and numbers 

using bold or italic, underlining or shading. You can also adjust the column width 

or row height and adjust the alignment of the text – centre, right, left or angle. You 

can choose how numbers are presented, such as in currency format, as decimals 

with a particular number of decimal places or in date format.

Headings

Headings in a spreadsheet are the letters above the  

columns and the numbers beside the rows. These 

headings are useful because they give you an 

understanding of where you are located within the 

spreadsheet. Some people prefer to work without the 

headings displayed. Headings can be turned on and 

o$ by selecting the Page Layout tab and checking or  

unchecking the Headings View box.

You can also choose whether to print headings.

Displaying or printing headings is useful when you are checking that 

information has been accurately entered, particularly when checking for errors 

with formulas or functions.

Headers and footers

Headers and footers are used to record common information in the margin 

of the report. The header is at the top of the page, while the footer is at the 

bottom. Headers and footers are automatically repeated on all pages of the 

spreadsheet. Headers and footers might include the company name and logo, 

name of the report, creation date and file reference information. 
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Adding and deleting columns and rows

To add a new column or row go to the Home tab and select Insert. 

Choose Insert Sheet Columns or Insert Sheet Rows from the 

drop-down menu. A new column or row will be inserted adjacent 

to the cell currently selected. 

To delete a row or column, select Delete. Choose the appropriate 

option to delete (cell, row, column or sheet). If you make a mistake, 

you can click Undo or press Ctrl+Z.

Using design features to enhance readability and appearance 

Styling and formatting spreadsheets can help to highlight key information and improve 

readability and appearance. 

For example, using titles for columns and rows, bold, colour, shading and borders can 

draw the reader’s attention to key information.

Be careful not to overuse styling, which can detract from the data and purpose of a 

spreadsheet to present clear information. 
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Practice Task 4
Consider and compare these two spreadsheet examples. 
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Question 1

What are the di$erences between the two examples?

Question 2

Which one is easier to read? Why?



Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting 41

Design and create spreadsheets   |   Topic 2

Spreadsheet styles and layouts

The layout and presentation of the spreadsheet should project your 

organisation’s image. 

Many organisations use spreadsheet templates to help maintain a standard appearance. 

These may have prede+ned fonts, headers and footers, logos, formulas and functions. 

For example, if you are required to produce a monthly report of +nancial information, 

the only di4erence each month will be the +nancial data. The formulas and overall 

appearance will be the same. Using a template with formulas already developed can save 

time. You must +rst determine if the formulas are the same as what is required in your 

current task. 

Templates and style sheets 

A template allows you to create a structure for other spreadsheets using 

common data and formatting options. 

A style sheet is similar to a template and is used to apply prede+ned information, 

formatting, formulas and functions to a spreadsheet. Style sheets can be protected to 

ensure that users cannot change anything apart from the information they are required 

to enter.

Style sheets and automatic functions are useful tools for ensuring that spreadsheets 

produced by di4erent people in an organisation are consistent in their appearance. This 

is especially important if your spreadsheet will appear with others in the same document 

or presentation. 

You can create a template from a blank workbook. Templates can also be accessed by 

selecting New from the File tab.  

To do this, create the spreadsheet component or structure you want to use, then select 

the File tab and choose Save As. Give the template an appropriate name, and use the 

Save as type drop-down menu to select ‘Excel Template’. 
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If you are working in Excel and the template is to be used by people who have an older 

version of Excel, you may need to choose the option ‘Excel 97-2003 Template’.

Some of the features you can incorporate into your style sheets are:

• borders

• page numbers

• alignment

• typeface styles and point size.

Borders

Borders are used to keep certain information separate 

from other parts of the spreadsheet or to highlight key 

information. 

To add a border, select the area where you want the 

border to apply. Select the Home tab and use the Borders 

drop-down menu to select the appropriate border. For 

more speci+c styling options for border, select More 

Borders, which allows you to select a style and choose 

which parts of the cell to apply it to.
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Headers, footers and page numbers

Headers and footers are used to incorporate information into the margin of a 

spreadsheet. 

Examples include current date and time, +le reference, and page numbers. 

To insert a header or footer click on the Insert tab and select Header & Footer. You will 

now be able to enter the required information or use the tool buttons to design your 

header and footer. After entering a header or footer, the onscreen view will change to 

Page Layout. To return to the normal view, select the View tab and click Normal.

Page numbering is commonly used in either the header or footer of the spreadsheet to 

show the total number of pages and the current page you are viewing in the printed 

version. To insert page numbers, select Header & Footer from the Insert tab. The Design 

tab will appear, then you can select the appropriate page numbering tool as shown below.

If you are showing both current page number and total number of pages, you need to 

manually type in ‘of ’ as this is not automated.

Alignment of text and values

Text and values align di#erently within the cell by default. Text aligns to the left, 

values to the right. 

To adjust the horizontal alignment of data in a cell, select the cell and 

choose the appropriate alignment tool from the Home tab. 

Horizontal alignment options include left, centred and right. Data 

can also be aligned to the top, centre or bottom of the cell. In 

addition, text can be oriented to be vertical or on an angle. This 

can be helpful to +t lengthy headings on the side of tables.
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Another common tool used to align cells is Merge & Center. This is commonly 

used to align a heading across the width of data in the spreadsheet. When using  

Merge & Center, the data to be merged across the cells must be in the +rst cell selected.

Look at the following example.

In this example, the headings ‘Henry Lewis Consulting & Co’ and ‘Sales results’ have 

been merged and centred across the columns A:G. To perform this action, each row  

is dealt with separately. First, the data from cells A1:G1 are selected and then the  

Merge & Center tool  on the Home tab is pressed. Next, the data from cells A2:G2  

is selected, and then the Merge & Center tool is clicked. This provides the data with  

a heading.

Extra space can also be added to the spreadsheet by adjusting the column width and row 

height. This can be done by positioning the cursor between either the letters of the 

columns to be widened, or the numbers of the rows to be made taller. A double-headed 

arrow will appear that will enable you to click and drag to adjust the column width or 

row height. 

Typeface styles 

To adjust the font, select the cell to be changed and make your selection using the Font 

tool and Font Size tool.

Styles can also be used to format cells. Styles apply formatting such as colour, borders, 

font type and size to the cell.

To do this, select the cells to be formatted by highlighting them. To format using styles, 

from the Home tab, select Cell Styles and choose an option.
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Default settings are the original settings of the spreadsheet, referred to in Excel as  

the Normal style. This style has preset formatting such as font type=Arial, font size=12.  

There is no other formatting applied to the Normal style. To adjust data to the Normal 

style, select cells to be adjusted, and from the Home tab, then select Normal   

in the Styles section.

Table headings

Data can be converted to a table format with headings, which can be useful for quickly 

sorting the data.

Tables make the information easy to work with, as formatting is automatically applied 

and it is possible to have the titles of the table automatically become headings. This can 

be useful for sorting and reviewing data. The following example demonstrates how data 

has been converted to a table format with headings.

The table headings have arrows that enable you to quickly sort the data.

To convert data to a table, select the cells by clicking and dragging to highlight them, 

then select Table from the Insert tab.
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Cell styles

In Microsoft Excel, there is an option to apply cell styles to the spreadsheet. These are 

prede+ned styles available for you to use. Styles relate to font type, font formatting, 

number formatting, borders and shading. Simply select the cells that require the style 

applied, choosing the Home tab, and selecting the Cell Styles button. From here you can 

choose to apply a prede+ned style or create a new style for future use.

You might choose to use di4erent prede+ned styles for row and column titles, the data 

contained in the spreadsheet and summary information. 

The following example shows how style choices can be used to improve presentation. The 

spreadsheet titles are formatted, merged and centred across the length of the data. Titles 

are formatted appropriately and end stock +gures are shaded to highlight the end result. 
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Practice Task 5

Question 1

Create the following spreadsheet and apply borders as shown – thin inside borders for key 

information, and a thick outline border for the entire report. Save the file to an appropriate file 

location and name it ‘August Car Sales’.

• Adjust the column width and row height to give more space. Adjust the alignment within 

cells to improve the presentation of the data. Start by centring vertically and horizontally.

• Format text by using di$erent font types and sizes and bold or italics.

• Use colour and shading to format cells.

Question 2

Use the information in the table below to create a spreadsheet that meets these requirements:

• Font: Arial 14, bold and italic

• Titles: shade background in yellow

• Border: thick outline

Save the file to an appropriate location and name it ‘Fashion Excess – stock on hand’.

Stock item Quantity on hand Cost per item Retail price per item

Knickerbockers 188 $45 $86

Flower power pants 191 $55 $92

Flare pants 192 $51 $98

Skirts 101 $18 $67

A-line skirts 76 $23 $87

Hot pants 177 $34 $76
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Question 3

Create the following spreadsheet and convert it to a table with headings. Practise using the 

heading arrows to sort and review the entries. 



Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting 49

Design and create spreadsheets   |   Topic 2

Page Layout view

The Page Layout view is used to quickly and easily make adjustments to the 

worksheet. 

Use this view to adjust the layout and format data as appropriate. It is possible in this 

view to change the orientation of pages, adjust headers and footers, and adjust margins, 

column width and row height. This view includes row and column headers and has a 

ruler for measurement. The Page Layout view appears on screen as follows:

To select this option, go to the View tab and select Page Layout. Adjust  

margins by positioning the cursor on the margin line in the ruler so it is a 

double arrow, then click and drag. The same process can be followed to adjust 

row height and column width. To adjust the header or footer, simply click into 

the entry and make appropriate changes. Orientation can be changed from 

portrait to landscape, and vice versa, by selecting the Page Layout tab and clicking  

on Orientation.
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Page alignment 

The page alignment can be adjusted to ensure that content is evenly distributed 

on the page.

When creating spreadsheets, it is best practice to begin your spreadsheet at cell A1. What 

occurs, however, is that when you print the spreadsheet, the information begins at the 

upper left of the page. This is reasonable for presentation of a longer report but if it is a 

shorter report, the spreadsheet will seem to be crammed into one corner. Look at the 

following example of page alignment.

To adjust the alignment so the information is centred in the page, follow these steps:

From the File tab, select Print, then select Page Setup at the bottom of the Settings 

panel. Select the Margins tab. Under Center on Page tick both Horizontally and 

Vertically. 

The Page Setup dialog box also provides a preview of your changes.
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Proofing and AutoCorrect

AutoCorrect automatically corrects common typing errors; for instance, if you were 

typing the word ‘what’, and accidently typed in ‘whta’, Excel will correct the error to 

‘what’. It is a handy feature, but only works for common words. 

The Proo+ng feature can be customised by selecting the File tab, choosing Options and 

selecting Proo,ng. Here you can select options such as Ignore words in uppercase and 

Ignore words that contain numbers. You can also click AutoCorrect Options and 

type in commonly misspelled words and what they should be replaced with.
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To check errors in labels, select Spelling under the Review tab. This identi+es misspelt 

words. It cannot assist with product names, customers’ names or addresses. Manually 

check your spelling and crosscheck it with the original data source. For example, you 

may have been given a printout of all customers’ names to be entered. Once you have 

entered the customers’ names, check them for accuracy against the printout.

You should check all information, including:

• name and address details

• spelling

• product information and pricing

• dates

• reference details; for example, catalogues and previous correspondence.

AutoText 

Excel recognises that you may have entered the same information 

previously. For instance, you may be typing in locations of retail 

outlets, such as Sydney, Melbourne and Adelaide. Once you have typed 

in these entries, when you type the data for the next entry, Excel will 

automatically provide an option for you to select from rather than 

retyping. Look at the example below:

In this example, as soon as ‘M’ is typed, it automatically completes the text to say 

‘Melbourne’. It is then only necessary for you to press enter to accept it. If it is another 

entry that you are completing – such as Malvern – just continue typing.
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Practice Task 6
Here is a spreadsheet and the original information used to create it.

Customer documentation

Customers Balance

Smith 55.00

Carter 4,000.00

Andrews 3,455.00

Phillips 3,000.00

Elliot 2,500.00

Franks 5,000.00

Louie 34.00

Question 1

How many errors are in the spreadsheet?
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Question 2

What are the consequences of numeric values being entered incorrectly?

Question 3

What should customer Smith’s balance be?

Question 4

Create the worksheet with accurate information. Save it to an appropriate location, and call it 

‘Customer Accounts’.
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Importing and exporting data

You may want to bring data into your spreadsheet from another application such 

as Microsoft Access; this is called importing data. 

For example, if the information you require is stored in a customer database, you may 

need to import customers’ contact details and other information.

The following tools, located in the Data tab under the Get & Transform Data section, are 

used to import data.

Exporting data to another application from Excel can be done by copying and pasting 

the required information. You might need to do this if the data needs to be analysed or 

presented in a di4erent way.

Keyboard shortcuts 

Keyboard shortcut commands are useful for speeding up data entry and formatting 

processes. 

It is possible to create macros to make your own keyboard shortcut commands for 

common actions, such as inserting a company logo. 

Common keyboard shortcut commands include:

• Ctrl+B to make selected cells bold

• Ctrl+I to make selected cells italic

• Ctrl+C to copy selected cells

• Ctrl+X to cut selected cells

• Ctrl+V to paste selected cells

• Ctrl+F to activate the Find function

Many other keyboard shortcuts are available. These are explained in Excel’s help 

function. 
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Practice Task 7
Open the spreadsheet called Customer Accounts you created in Practice Task 6. 

• Go to Print to see how the spreadsheet will look when printed. 

• Adjust the page alignment so it is centred on the page both vertically and horizontally. 

• Check with Print Preview.

• Practise inserting and deleting columns and rows. Do not save the changes you make. You can 

also practise changing cell widths.

• Use the Help function to investigate keyboard shortcut commands available in Excel. Search for 

Excel shortcut and function keys. 

• Practise using some of the shortcut keys to change the format of the spreadsheet.
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2B Using and testing formulas and functions 

Formulas and functions are at the heart of a spreadsheet. They take your data 

and manipulate it in various ways to give the outputs needed.

Functions are a type of formula that performs more complex calculations. Perhaps the 

simplest of these to understand is the SUM function, which is a complex form of adding 

values from a range of cells together.

Excel uses formulas and functions (built-in formulas) to manipulate numbers so you can 

analyse them however you need to.

Some typical ways a spreadsheet can make analysis of data quick and easy are by:

• calculating the average of numbers

• calculating the totals of a list of numbers

• working out percentages

• calculating simple and compound interest using formulas.

You can enter a formula into any cell. To do this you must start with an = sign so the 

spreadsheet knows that it is a formula.

The most basic operations a formula can do are:

• add using the + symbol 

• subtract using the – symbol 

• multiply using the * symbol

• divide using the / symbol 

If you want to add two numbers enter the +rst number into a cell (such as A1), then 

enter the second number into another cell (such as A2). Type a formula into another cell. 

For this example, type =A1+A2 into cell A3. When you press Enter on the keyboard, the 

answer to the calculation will be displayed in cell A3.

If new numbers are typed in A1 and A2, cell A3 will automatically display the new 

answer when Enter or an arrow key is pressed. This means you do not have to type the 

formula all over again; it stays there, processes the data from A1 and A2, and records the 

result in A3.
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Functions

A function is a formula that is built into a spreadsheet. 

Functions can save a lot of e4ort by doing quite complex calculations in one cell. Excel 

provides functions to do a variety of common calculations, such as SUM or AVERAGE. 

For example, =SUM(B5:B17) adds all the numbers in the range of cells from B5 to B17. 

Functions can be used in Excel to perform a variety of mathematical, statistical and 

+nancial calculations to help you to analyse information. Some common functions used 

in Excel are shown in the following table.

=SUM(range) Adds the numbers in the cells that are within the range specified in the 

brackets

Example: Calculates the total sales figures for a given period

=MAX(range) Finds the highest value from cells that are within the range specified in the 

brackets

Example: Shows the highest student result from the group

=MIN(range) Finds the lowest value from cells that are within the range specified in the 

brackets

Example: Shows the lowest student result from the group

=AVERAGE(range) Finds the average of numbers in the cells that are within the range 

specified in the brackets

Example: Shows the average result of all students

=COUNT(range) Counts the number of items in the range

Example: Counts the number of results entered for the class

Automatic functions

If you have created a formula in one cell, and you want to repeat it in additional 

cells, you can either copy it or use automatic functions.

AutoFill is used to repeat sequenced information that aligns with the selected cell. Use 

the AutoFill handle  to repeat the sequence of formulas and functions. 

AutoSum enables you to add values automatically using the SUM function. Select a range 

of values that you want to calculate and select AutoSum, which can be accessed from 

the Home tab.
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Checking and amending data

If the information contained in the spreadsheet is not accurate it will cause problems for 

others and re@ect poorly on the company you represent. For example, you might mistype 

the +gures in a summary of house sale prices. Taking the time to check information and 

making sure it is correct helps to save time, improve e2ciency and increase customer 

and organisational satisfaction.

Remember, if your input is wrong, your output will also be wrong.

Producing spreadsheets requires you to follow instructions. Instructions may be given by 

your manager or supervisor, the person requesting the spreadsheet, past spreadsheets or 

instruction manuals. Instructions may relate to the spreadsheet’s content or its format 

and layout. 

For example, you may be asked to produce a sales report summarising weekly +gures, 

and provide a comparison of actual results with target results. You may be required to 

identify sales personnel and specify their performance in terms of actual and target 

performance. These instructions provide guidance on what is required for the report and 

how it is to be produced.

If instructions are not followed, it may delay the +nal production of the report, or 

reduce the usefulness, meaning and credibility of the information. If you need to clarify 

instructions, or have your own ideas about how the spreadsheet could be improved, 

speak to your manager or the person requiring the information.

Testing formulas and functions 

In complex spreadsheets, there might be several possible answers, depending 

on the order in which calculations are carried out.

You should input test data and use a calculator to work out what answers your 

spreadsheet should give. For instance, if your formula is meant to give the average of +ve 

numbers in cells B1 to B5, then make up some numbers and put them in the spreadsheet. 

Add up the same numbers on a calculator, then divide by +ve to see if you have the same 

answer produced by the formula. If not, you have probably made one of the following 

mistakes: 

• typing in the wrong cell reference in a formula (such as B11 instead of B1)

• making a mistake when typing the formula (such as typing + instead of *)

• using the wrong formula.
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It is important to always check your spreadsheet for accuracy. This may include double-

checking with stakeholders, like your colleagues or manager, to make sure the data you 

have entered is correct. As well as checking the values you have entered, you should also 

ensure that any labels are spelt correctly and that you have formatted all data to suit 

organisational requirements.

You may be able to give the information you produce to a colleague or supervisor to 

check in draft form before you complete the +nal version. 

Use the Show Formulas tool   in the Formulas tab to review formula 

entries.

Check the spreadsheet to ensure:

 � the accuracy of data entered

 � formulas are working correctly

 � all instructions have been followed

 � the design and layout are consistent.

Practice Task 8
Read the case study, then answer the questions that follow.

Case study

Helen has recently taken up a position as an administrative o$icer with a government department. 

Her manager asks her to compile a spreadsheet report analysing the number of people who have 

travelled overseas in the past year, as well as information on countries visited. She has also been 

asked to ensure that she follows standard guidelines for producing the report, such as use of 

corporate colours, font type and size and the company logo. The report from the spreadsheet is to 

be distributed to media outlets. A graphical representation showing the top 10 locations for travel is 

also required.

Question 1

Who is the audience for the spreadsheet?
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Question 2

What is the purpose of the spreadsheet?

Question 3

What are the information requirements?

Question 4

What are the elements of spreadsheet design that Helen needs to consider?
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Error alerts

Excel has many features to help you identify errors, such as an inconsistency in a 

formula. 

In the following example, a small arrow in cell F6 indicates there is an error in the 

formula.

If you select the cell with the alert, a help bubble will appear that explains the error that 

Excel has identi+ed.

If you are unsure what the error is, you can also use Formula Auditing tools in the 

Formulas tab to investigate errors and determine what action needs to be taken to 

correct them. 

Another useful feature is the Trace Precedents tool, which shows a diagram of where 

the data in the calculations comes from. To use this tool, select the cell that contains the 

error and then select Trace Precedents in the Formulas tab. The spreadsheet will show 

preceding connections, as in the following example.
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It may also be necessary to consult with colleagues, your manager or the person who 

has requested the spreadsheet to con+rm the results of the formula. If the results do 

not appear to be correct, take appropriate measures to check the entries. This includes 

checking calculations as well as source data. If you are still in doubt, seek advice from 

your manager or colleagues.

If you +nd there is no error in the formula indicated in the warning message, you can 

choose Ignore. This will remove the green error @ag from the spreadsheet.

Absolute and relative cell addresses 

Relative references change when you copy and move cells, whereas absolute 

references do not.

The cells in an Excel spreadsheet are all relative to each other. This means that if you 

place a value in one cell and then move it, the values will alter as the cell collects 

information from other cells around it. For example, the totals you calculated for each 

of your columns may need to be moved to another part of the spreadsheet. However, if 

you move the totals values to another location, the values would alter as the cells are no 

longer reading information from the cells immediately above them. This kind of reference 

is called a relative reference.

This can be very important if you shift a formula, because you may need to decide if the 

cell references in it should stay the same (absolute references) or stay in the same relative 

position (for instance, always one cell above the formula).

To make the values remain the same wherever you place them in the spreadsheet, you 

need to make the reference absolute. To make a cell reference absolute, use $ in the 

reference, such as in the following examples:

 =C5+B5 is a relative reference.

 =$C$5+$B$5 is an absolute reference.
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Practice Task 9
In this exercise you are going to create a formula to calculate the values for the Profit column.

Question 1

Create a spreadsheet named ‘Warehouse Profit’ using the data below.

Question 2

Create a formula to calculate the profit. Ensure you use the cell references and not the actual 

numbers in the cells. Select cell D4 and enter the formula =B4–C4. Press the Enter key to 

perform the calculation.

Once you have a calculation, use AutoFill to repeat the calculation in the remainder of the 

column. Your worksheet should now look like the following example.
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Question 3

The tax values need to be calculated as 10 per cent of the profit. In cell E4, enter the formula 

=10%*D4 (this will give you 10 per cent of the value in D4). 

Press the Enter key to perform the calculation.

Use AutoFill for the remainder of the column. 

Question 4

Select cell F4 and enter the following formula =D4–E4. This calculation subtracts the Tax from 

the Profit, giving you an End Profit value. Press the Enter key to perform the calculation.

Use AutoFill for the remainder of the column. 

Question 5

Open your Warehouse Profit spreadsheet. Select cell B10. From the Formulas tab select Insert 

Function. You will see the following dialog box. Select SUM and click OK.
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Question 6

As you have selected a cell at the end of a column full of numeric values, the SUM function is 

going to add all of these values together. Number 1 shows the formula the SUM function will 

use to make the calculation and the formula result is displayed at the bottom of the dialog box. 

Click OK. Cell B10 should now hold the calculation of all Income values added together.

Question 7

Repeat step 6 for the following cells: C10, D10, E10 and F10. Your worksheet should now look 

similar to the following example. 

Question 8

Describe how you might test formulae and spreadsheet data to ensure your calculations  

are correct.
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Practice Task 10
Enter the following data into a new spreadsheet.

Question 1

To calculate the January commission, enter the formula =B3*C3 in cell D3. Press Enter then 

use AutoFill to complete the column. Save the file as ‘January sales commissions’.

Question 2

Label row 8 ‘Highest commission’. Select AutoSum, then MAX to calculate the highest 

commission for January. Ensure the range is set to (D3:D7)

Question 3

Label row 9 ‘Lowest commission’. Select AutoSum, then MIN to calculate the lowest 

commission. Ensure the range is set to (D3:D7)

Question 4

Label row 10 ‘Average commission’. Select AutoSum, then AVERAGE to calculate the average 

commission. Ensure the range is set to (D3:D7)

Question 5

Label row 11 ‘Total commissions’. Under the Formulas tab, select AutoSum, then Sum to 

calculate the total of the January commissions. Ensure the range is set to (D3:D7)

Question 6

Label row 13 ‘Number of sales people.’ Under the Formulas tab, select AutoSum, then Count to 

calculate the number of sales people.  Ensure the range is set to (A3:A7).
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Common problems when producing spreadsheets

It is inevitable that problems will arise when designing and producing 

spreadsheets. 

Fortunately, there are many resources to help you overcome them, including referring to 

the Excel help function, training manuals and instruction guides. You may also be able 

to obtain assistance from colleagues or managers. If the problem is still unresolved, you 

may need to seek specialist help from your organisation’s IT sta4.

The following table shows common problems that occur when producing spreadsheets.

Problem/issue Example Action to take to correct 
the problem

Data entry is 

incorrect

• Misspelt names

• Incorrect figures

• Missing data or information

• Check spelling

• Proofread and check 

spreadsheet data

Text overflows 

or truncates

• Text entry flows into adjacent cell

• If an adjacent cell contains data, text 

appears to truncate

• Adjust column width

• Apply Text Wrap to the cell

Text not in full 

view

• Adjust row height

• Align content to the top of the 

cell

Numerical 

entry has too 

many digits

• Use fewer digits in the cell (if 

possible) – there is a limit of 15 

digits per cell 

Date 

formatting not 

consistent

• Adjust date formatting to the 

same format throughout

Number 

displayed as 

###

• Adjust column width
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Problem/issue Example Action to take to correct 
the problem

Cell alignment 

not consistent

• Adjust alignment of cells – both 

vertical and horizontal

Incorrect 

calculation 

result

• Check formula or function inputs

• Check data entry

Result of 

calculation 

appears with a 

#VALUE! alert

• Check formula or function input 

– this alert appears when a cell 

containing letters is included in a 

calculation

Green error 

alert

• Click on the green alert – a 

message will appear to explain 

the possible problem 

• Investigate error and make 

necessary corrections

• Use the warning menu to make 

appropriate choices 

Investigation 

into possible 

errors in results 

needed

• Use the Formula Auditing tools 

to track the formula – this can 

only be used if the formula has 

been input using cell references 

such as =A1+A2
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Help resources 

Working with software applications can be quite complex and there may be 

times when you need to seek assistance. 

Excel has a built-in help function, but if you cannot +nd the answer there you may need 

to seek the advice of an experienced Excel user such as a supervisor, colleague or IT 

support person.

Here are some other avenues you can access when you need help.

Manuals and training

Your organisation may have task- or role-specific manuals to help you produce 

spreadsheets. These provide guidance and assistance on the types of 

information a spreadsheet should contain or may specify the instructions to be 

followed for formatting and designing spreadsheets. 

Excel software comes with user manuals that describe the software features 

and provide step-by-step instructions for carrying out di$erent functions. You 

can find manuals in paper-based and online formats. 

You may have been to a training course to learn a particular computer function. 

Training courses usually provide a comprehensive set of instructions or notes 

that are worth keeping for future reference.

Online help

You can find information about Microsoft O$ice applications on many di$erent 

websites. These often contain frequently asked questions and solutions to 

common problems. You can also download updates, tools and any fixes 

Microsoft has developed for software problems. You may find the following 

websites useful:

• aspirelr.link/microsoft-support

• aspirelr.link/microsoft-o$ice

Tool buttons

Each time you move your mouse pointer over a tool button and leave it there 

for a moment, it will display a tip that tells you what the button is used for. For 

instance, from the Home tab, move your mouse pointer over the Font tools. You 

will notice the help tip for the Font Colour tool button.
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Practice Task 11
Read the case study, then answer the questions that follow.

Case study

Chinh works as an administrative assistant in a small manufacturing organisation. One of his tasks 

is to create Excel spreadsheets for his supervisor.

When creating spreadsheets, Chinh often needs to use Excel help to answer questions about 

software functionality. If he is unsure of a screen icon’s function, he presses Shift+F1 and points to 

the icon with his mouse.

Recently, Chinh attended a two-day Excel training course at a local community centre. He keeps 

the training booklet they handed out on his bookshelf. It has a handy index at the back for quick 

solutions to problems. He has also photocopied pages from various manuals he found around the 

o$ice and has placed them in a help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be easily solved. Chinh then 

uses Microsoft’s support website to find a solution, or he refers to the paper-based material he has 

gathered.

Question 1

If Chinh experiences software functionality problems, where does he go for help? 
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Question 2

Describe how Chinh uses paper-based manuals for help.

Question 3

If you experience a software problem when creating a spreadsheet, describe the steps you 

should take to solve the problem.
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Summary

• Spreadsheets are used to analyse data and present the results in a clear and 

comprehensive way.

• When designing a spreadsheet, you need to know its purpose, who will use it and 

the inputs, processing and outputs required.

• The design of the spreadsheet should meet the needs of the person requesting it, 

as well as organisational expectations and standards.

• You can use formatting, charts and other graphics to improve the readability and 

overall presentation of the spreadsheet.

• Formulas and functions simplify the processing of data.

• Automatic features can be used to save time and reduce errors.

• Spreadsheets should be consistent in design and layout.

• Spreadsheet design and layout must adhere to organisational and task 

requirements.

• Text, numerals, date and time, formulas and functions can be entered into a 

spreadsheet.

• It is important to proofread and check spreadsheets to ensure accuracy of the end 

product.

• Formatting options provide a means to improve the readability and design of 

spreadsheets.

• Formulas and functions allow repetitive calculations to be done automatically. All 

the user has to do is change the data.

• Excel has a number of ways to identify and correct errors in a worksheet.

• There are many ways you can get help, including referring to manuals, help desks 

and online support.
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Learning Checkpoint 2

Design and create spreadsheets

Part A
Read the case study, then complete the tasks that follow.

Case study

You work as an administrative o$icer for Eastern Employment Agency. The marketing manager 

asks you to create a spreadsheet to be used as a summary report to promote their achievements 

in work placements. Information is to be presented to show weekly results as well as monthly 

achievements of the past quarter. The weekly information for the report is as follows:

Week ending Client 
numbers 
at start of 
the week

New clients Number 
of clients 
placed in 

work

Number of 
voluntary 

placements

Number 
of paid 

placements

7 January 5038 123 1231 402 829

14 January ? 234 1234 341 893

21 January ? 12 435 123 312

28 January ? 43 1121 455 666

5 February ? 341 341 23 318

12 February ? 121 234 28 206

19 February ? 12 432 231 201

26 February ? 42 123 53 70

5 March ? 411 532 43 489

12 March ? 123 522 234 288

19 March ? 12 100 50 50

26 March ? 234 123 12 111

To comply with your organisation’s requirements you must:

• insert a header stating the name of the business

• insert a light blue background shading

• use a thick outline border and a thinner line for inside borders

• bold titles

• use Arial font type 

• use size 14pt font. 
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1. Create a report of the weekly results and calculate the client numbers at the start of each week. 

2. Use appropriate cell references to complete the calculation. 

3. Calculate as follows: 

Client numbers at start of week = number at start of previous week + number of new clients – 

number of clients placed in work.

4. Create a monthly summary report as requested by the marketing manager. Use the SUM 

function to calculate summary figures for each month. 

5. Save the file to an appropriate location and name it ‘Work placement summary’. 

Part B
Read the case study, then complete the tasks that follow.

Case study

Mara works as an employment coordinator for Eastern Employment Agency. She has been 

asked to produce a monthly summary report for the operations manager to present at the next 

management meeting. The report is to show the number of paid work industry placements. The 

information will be used to analyse market segments. 

Organisational style requirements for the spreadsheet are as follows:

• Header stating the name of the business

• Light blue background shading 

• Thick outline border and a thinner line for inside borders

• Bold titles

• Arial font type 

• Size 14pt font

Mara produced the following spreadsheet for the operations manager.
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1. What is the purpose of the spreadsheet?

2. Who is the spreadsheet for?

3. What are the task requirements or information requirements for the spreadsheet?

4. What are the organisational requirements for the spreadsheet?
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5. Has Mara produced a spreadsheet that conforms to the organisational and task requirements?

6. What could Mara do to improve the overall readability and appearance of the spreadsheet?

7. How would a style sheet help Mara?
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Part C
Read the case study, then answer the questions that follow.

Case study

Gabby works for a market research firm as a research assistant in the product testing department. 

One of their recent projects has been to undertake a focus group to analyse and evaluate the 

possible launch of a new ice-cream into the marketplace. The spreadsheet summary results should 

look similar to the following.

Gabby is required to do the following:

• enter all result data using the predefined style (template)

• use the AVERAGE function to analyse overall ratings.

Gabby is new to using Excel and is not sure how to access and use the style sheet. She knows how 

to use the SUM function, but was not sure about the AVERAGE function. 

Gabby decides to produce a spreadsheet that contains all the relevant information and presents 

that to the product manager. Gabby’s spreadsheet looks like this.
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1. What mistakes has Gabby made in the production of the spreadsheet?

2. What should Gabby have done to proof and check the spreadsheet?
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3. If Gabby thought there was a problem with the results of the calculations, what could she have 

done to check it?

4. What should Gabby have done to find out about style and the AVERAGE function?

5. How would Gabby work out the number of people in the focus group?
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3A Selecting an appropriate chart type and design

3B Creating and modifying charts
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3A Selecting an appropriate chart type 
and design

When producing charts, it is important to follow both organisational and task 

requirements. 

An organisation may have a set preference for the types of charts it uses. For example, it 

may prefer to use column charts as opposed to line charts because they make it easier 

to analyse the information. An organisation may also use certain colour codes for the 

presentation of data; if this is the case, these rules should be followed to ensure the 

organisation’s image remains consistent.

Task requirements can depend on a set of instructions and protocols for producing 

charts. You may be asked to prepare a summary report of monthly sales as well as a 

chart. If this is the case, you may need to produce two separate documents. If the policy 

is that a certain type of chart design is used for the production of various reports, you 

need to do this. 

If you have any suggestions for improving the readability and analysis of charts and their 

associated data, discuss them with your supervisor or manager.

Types of charts and their features

The types of charts you can select include: 

• area 

• bar

• column

• pie

• line 

• scatter.

Charts are a good way to show the results of the spreadsheet analysis because they can 

be grasped quickly, without the user having to do too much thinking. For example, a pie 

chart or a bar chart could be used to show what percentage each of several models of 

cars contributes to total sales. To show how the temperature in a coolroom varies over 

several weeks, a line chart or a scatter chart would be best. 

The kind of chart you choose and its design should re@ect your organisation’s needs and 

the task requirements. 

The following example shows the percentages of types of cakes sold in a bakery presented 

in a pie chart. It is easier to look at the cake shop data in a chart rather than looking at 

the +gures in a worksheet.
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Charts in Excel are linked to information contained in the selected cells. This means that 

if the cell data is updated, the chart is also updated.

Area chart

Area charts can be used to demonstrate changes over time. 

For instance, they may be used to compare changes to sales over the past 12 months. 

The following example shows how yearly real estate sales +gures vary for di4erent 

outlets.
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Bar charts

A bar chart displays information as a series of horizontal bars. 

These charts are useful for comparing data arranged in columns or rows. Bar charts 

show the di4erences between individual items.

The following example shows how monthly sales vary for di4erent departments of a 

retail outlet.

You can use a stacked bar chart to compare the values of individual totals to a total 

across multiple categories. 

The following example compares monthly department sales +gures, as well as the total 

overall amounts for the sales quarter.
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Column charts

A column chart has vertical columns and is useful for comparing separate types of data 

from a data series. 

The following example shows how rainfall data in Sydney and Melbourne can be 

compared using a column chart.

If you prefer the 3D look for your column chart, choose 3D when making your chart 

selection.

You can use a stacked column chart to compare the values of individual totals to a total 

across multiple categories.

The following example compares monthly rainfall for Melbourne and Sydney, as well  

as the total overall amount.
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Pie charts

A pie chart shows a data series in percentage segments. 

It is useful for showing data as a percentage of a whole. Pie charts are commonly used to 

show which products are selling or how much market share an organisation has. 

The following example of a two-dimensional pie chart shows the market shares of +ve 

health food companies.

If you prefer the 3D look for your pie chart, choose 3D when making your chart selection.
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Line chart

A line chart shows the movement of values in a data series using single or multiple lines. 

It is useful for showing how the values of a data series can change over a period of time. 

The following example uses a line chart to compare total monthly rainfall in Melbourne 

and Sydney.
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Scatter chart

A scatter chart is used to compare and arrange data to analyse the relationships between 

numerical information. 

A scatter chart displays clusters and is commonly used for statistical comparisons. 

The following example uses a scatter chart to display and analyse estimated and actual 

sales results. 
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Practice Task 12

Question 1

Using this table, note what type of chart would be best for displaying the information and 

explain why.

Data to be included 
in a chart

Type of chart 
used

Reason

Percentage of actual 

sales for individual 

product items

Profit for individual 

retail outlets 

compared with last 

year

Comparison of 

workplace hazards 

identified in the 

organisation

A chart to show 

changes in 

workplace hazard 

identification over a 

given period of time

Read the case study, then answer the question that follows.

Case study

Juicy Fruits is a fruit supplier specialising in fruit baskets for corporate organisations. At the end of 

each month, a report is compiled tallying all the fruit supplied. Information reported on includes 

product type, number of products supplied and sales figures. 

Julian Ali, the business owner, is happy with the reports, but realises that some of the supply 

coordinators are finding the information cumbersome to interpret. Julian decides that in addition 

to the reports, he would like to trial preparing the information in chart form to compare the supply 

data of each of the products. He believes that a graphical representation of the data will be easier 

for the coordinators to decipher and compare. 
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As the administration supervisor, Julian has asked you to prepare an example of how the data 

would be presented in chart form. Julian has asked that you use bright colours in the charts as this 

complements the style and colour range of fruit types supplied by the business. He has also asked 

that you present the information in column form with product supply numbers and product types 

identified in the chart. It is important that there is a heading on each of the charts to clearly identify 

the information that is being reviewed.

Question 2

What are the organisational and task requirements for producing the charts?
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3B Creating and modifying charts 

To create charts in your spreadsheet, you need to know the purpose of the chart 

and the data you plan to present. 

This helps you choose the most appropriate type of chart to use. The data to be presented 

in the chart is known as the data range. This information may include text and numeric 

data. The numeric data is what is represented in the chart and the text relates to the 

series (or group) of data.

The following information explains the meanings of common terms.

Axis

An axis is a line that labels the information in a chart according to the labels 

in the columns and rows of your spreadsheet. Axes provide a reference for 

measurement or comparison of the data in the chart. Most charts have a 

vertical axis (known as the Y-axis) and a horizontal axis (known as the X-axis).

Category

Categories are the names that are placed along the X-axis of a chart and are 

determined by the labels in your spreadsheet.

Data range

The data range is the selection of values you choose from a worksheet to place 

in a chart; for example, all the numbers in one row or one column of data.

Legend

The legend is the key used to identify the various data series. If you include 

the series labels from your worksheet, Excel will add these to the legend. 

Otherwise the legend will simply say series 1, series 2, etc.
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Producing a chart

To produce a chart, you must +rst enter data into a worksheet. 

Select the data either by clicking and dragging over it with the mouse, or by selecting one 

of the cells, then holding down the Shift key and pressing the arrows on the keyboard. 

Use the Insert tab and select the appropriate chart under the Charts section. The type of 

chart you choose will depend on your organisational requirements. 

A chart is linked to the worksheet it is created from, so if you alter the data in the 

worksheet, the chart will be automatically updated.  

Practice Task 13
Create a spreadsheet, with the data below for Hemline Miller, showing sales, customer numbers 

and quantities sold. 
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Question 1

Create a column chart that compares the sales data. Include the chart heading ‘Hemline Miller 

– January sales’.  

Question 2

Create a scatter chart that compares customer numbers with quantity sold. Include the chart 

heading ‘January – customer numbers vs quantity sold’.

Question 3

Create pie charts for the following, with relevant headings and data labels showing percentages 

of total sales (save your file as ‘Hemline Miller January Report’).

a) Sales

b) Customer numbers

c) Quantity sold
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Practice Task 14
Take the following steps to produce a column chart.

1. Open Excel and enter the data below into a worksheet. Save the worksheet as ‘Company cars’.

2. Select cells A4 to E9. This selection should cover all the labels and values. This selection has 

now become your data range. Do not include any blank rows or columns in your selected cell 

range.

3. Go to the Insert tab and select Insert column chart. The chart will now display as an object  

in your spreadsheet.
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4. To move the chart to a separate sheet in the workbook, go to the Design tab and  

select Move Chart.

A dialog box will appear. Select the option to place the chart in a new sheet. Give it 

an appropriate name, e.g. ‘Cars by state’. Click OK.

5. The chart will now have a separate sheet in the workbook. If you look at the worksheet names, 

you will notice that the chart now appears there.

6. If the data you want to include in a chart is not in adjacent rows and columns, use the Ctrl key 

to make multiple selections in di$erent locations on your worksheet.
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Formatting charts

Once you have created a chart, you need to format it to suit your organisational 

requirements and make it easier to understand. 

You can improve the appearance and ease of understanding by using titles, axis labels, 

legends, colour and changes to layout. You can format the data range, text and legend or 

add a pattern to the chart area. Look at the following example of a chart and notice the 

di4erent components that can be formatted.

Each component of the chart can be formatted by selecting the item, right-clicking on  

it to display the shortcut menu and then making formatting choices as appropriate.  

You can also use the Chart Tool buttons.

Purpose of formatting charts

You will need to format your chart to adhere to organisational and/or task requirements. 

Formatting the chart can also enhance presentation and the information’s overall 

readability.

Balance the time taken in preparing the chart with the required output medium. 

For example, if you do not have a colour printer and are not presenting the charts 

electronically, it will not be necessary to spend a lot of time selecting colours. You will 

only need to ensure the font type and size is appropriate and that the chart is well 

presented.
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All parts of the chart are separate components and can be formatted and adjusted as 

appropriate. To select a part of the chart, point and click to select it – then use the tool 

bar or right-click mouse shortcut menus to make appropriate changes. 

Titles in a chart are separate objects and can be moved around and re-sized by clicking 

and dragging with your mouse.

Practice Task 15
Take the following steps to format a chart.

1. Open the spreadsheet with your Company 

Cars chart. Click inside any of the data 

series columns. Right-click your mouse and 

select Format Data Series. You will see the 

following Format Data Series dialogue box.

2. Click Fill and select Gradient fill, then 

choose a preset colour and click Close. You 

will notice that the data now has a shade 

e$ect in the chart. If you want to change 

the look to something di$erent, instead 

of selecting Gradient fill, select Picture 

or Texture fill, and select an appropriate 

texture. 

3. Repeat this process to choose gradient fills 

for the other columns. 

4. The Plot Area is the space behind the 

columns. The Chart Area is the space 

behind the legend and the chart labels. 

Right-click in the Plot Area and select 
Format Plot Area. In the dialogue box, 

select Solid Fill and choose an appropriate 

colour. Click Close.

5. Right-click in the Chart Area and select 

Format Chart Area. In the dialogue box, 

select solid fill and choose an appropriate 

colour. Click Close. 

6. To add a border to the Chart Area, right-

click and select Format Chart Area. From 

the dialogue box, select Border colour, 

choose Solid Line and make the colour 

black. Click Close.
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7. To add a Chart title, select Chart Title and then Above Chart from the Layout tab.

8. To add axis titles to the chart, from the Layout tab select Axis Titles, and add a horizontal title 

and vertical title.

9. To format the text in the Chart title, select the Chart Title, and use the formatting tools on the 

Home tab. 

10. To add data labels to the chart, select Data Labels from the Layout tab, and then select an 

appropriate position in the chart (such as centre). 

11. Format gridlines in the chart by right-clicking and selecting Format Major Gridlines. Select 

Line Style and choose a dashed line style. Click Close.

12. The chart should appear similar to the following example.
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Modifying charts

A chart may need to be modified. This could mean changing the chart type or 

data range, or reformatting the chart.

Formatting changes are done with the chart tools or by right-

clicking in the chart area or plot area. Once you insert a chart 

into your worksheet, you will notice that two new tabs appear 

– Design and Format.

The following provides a list of tools you can use to format and modify charts.

Design tools

• Design tools allow you to change the type of chart selected, adjust the style and layout, 

alternate the view of data between row or column, and check or adjust the data selected.

• The Chart Layouts section can be used to change the way the chart is set out. Layout tools 

allow you to adjust the appearance of the chart by adding titles, labels, gridlines, etc.

• Chart Styles can be used to change the colours and presentation of the chart. 

• The Data section can be used to change the data range or adjust the way data is presented 

in the chart.

• You can select Change Chart Type to change the chart type (for example, from a column 

chart to a line graph).



100 Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting

BSBTEC302   |   Design and produce spreadsheets

Format tools

• Format tools enable you to alter the general appearance of the chart, such as colours, font 

type and font size.

• You can use the Current Selection group to adjust the appearance of various components of 

the chart (such as chart title and plot area).

• The Insert Shapes section can be used to add shapes and text. You can also use the Insert 

tab to add pictures from external sources.

• The Shape Styles and WordArt Styles sections can be used to add e$ects to shapes and 

labels used in the chart.

• The Arrange section can be used to display the selection pane, which enables you to hide 

or display charts in the spreadsheet.

• You can also change the height and width of the chart, adjusting the overall layout. 
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In addition, you can format the chart by clicking on it and selecting options from the 

drop-down list. The +rst option allows you to add elements such as a trendline and data 

table, whereas the second option allows you to change the style and colour scheme.

A window will also appear on the right allowing you to format the plot area.
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Summary

• A chart is a graphical representation of selected worksheet data.

• Charts are visually appealing and make it easy to display comparisons, patterns 

and trends in data.

• The type of chart you choose to display data depends on organisational and task 

requirements.

• Each component of a chart can be formatted and adjusted as needed.
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Learning Checkpoint 3

Produce charts

Part A
1. Write a short paragraph for each of these chart types explaining the type of data most suited to 

each type:

a) Pie

b) Column

c) Scatter
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d) Line

2. Use the data below to create the following charts. Save the spreadsheet to an appropriate 

location and name it ‘Jim’s Booksellers – January sales comparison’.

a) A pie chart to show percentage achieved for individual sales consultants

b) A column chart to show target and actual sales figures for individual sales consultants

c) A scatter chart to show clusters of actual sales with percentage achieved

To calculate the percentage in the last column you need a formula that divides the actual sales by 

the target sales.

Jim’s Booksellers 
January comparison – target sales figures to actual sales figures

Sales consultant Target Actual Percentage of target achieved

Amanda $80000 $71891

Geraldine $75000 $72910

Harry $68000 $62820

Jim-Bob $87000 $92192

Maureen $85000 $78282

Part B
1. Open the spreadsheet ‘Jim’s Booksellers – January sales comparison’, which you made in Part 

A. Format the pie chart as follows:

• Use the Design tab tools to make adjustments to layout and style. Make choices according 

to your preference.

• Add data labels to the charts.

• Add gridlines, as appropriate, to the charts.

• Format the plot area using a gradient.

• Add a shape to the chart to identify the highest-achieving sales consultant.

• Use WordArt styles to format the chart title.

• Use Shape styles to apply dark borders around the chart.

• Preview your charts before printing on an individual page.
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4A Finalising and reviewing spreadsheets

4B Printing spreadsheets 

4C  Naming and storing spreadsheets appropriately
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4A Finalising and reviewing spreadsheets 

There are some standard ways to help meet time lines for data entry and to meet 

the accuracy requirements for the task.

Whenever you are given a work task, you need to plan a timeline. A timeline breaks the 

task into steps and details when each step must be completed by.

Find out when the spreadsheet is required and enter the date in your diary. Identify and 

plan the task requirements to work out how long it is likely to take. You will need to plan 

carefully to avoid a last-minute panic. If you are developing a spreadsheet for someone 

else, always clarify exactly what is required; for example, are formulas needed and do you 

have to create a new column? If you have to write formulas, make sure you allow enough 

time to have them checked by your manager.

If you are relying on others to provide you with data, you need to allow for this. You 

should give reminders and follow up so others do not delay the whole project.

Organisational time lines

Your supervisor may give you the deadline for completing set tasks; for example, 

preparing a draft summary report by 2pm. You may also have regular deadlines for 

common tasks, such as creating a monthly report of customers who are overdue in 

paying their invoices.

Using a diary system and a to-do-list can help you prioritise tasks and stay aware of the 

timelines required for tasks.

You may +nd you have con@icting work priorities and timelines. In these situations, your 

supervisor may be able to help you by suggesting ways to meet the deadline, or they may 

be willing to adjust the deadline.
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Preparing a checklist

Creating spreadsheets will become easier once you are familiar with your organisation’s 

requirements. In the meantime you can prepare a checklist to help you plan your work 

tasks. 

Look at the following example of a checklist.

Task Deadline Requirements Completed

Create a spreadsheet  

for the manager

Tuesday 20 

March

• Collect the product data

• Check the data

• Enter the data

• Proofread the data

• Format the spreadsheet using the 

organisation’s style guide

• Create a new column named ‘Interest’

• Write a formula to calculate 10 per cent  

of customers’ balances

• Create a column named ‘Sale price’

• Write a formula to calculate the new  

sale price



Accuracy of data

The accuracy of the outputs from your spreadsheets will depend on the accuracy 

of the data going into them.

You must ensure that the data being entered is good enough to achieve the task; for 

example, if the manager wants calculations to two decimal places and your data is very 

rough, then the answers you provide may be meaningless.

Try to stick to timelines and use the software appropriately and e2ciently, to save 

time and ensure that data is accurate. It is better to complete the task carefully and 

methodically rather than producing work that needs to be repeated due to inaccuracies.

When you are planning a spreadsheet task, you may think that designing and creating 

your spreadsheet is the biggest part of the job. Yet collecting, checking and entering the 

data can take a long time. This part of the process can cause delays, especially if you need 

other people to contribute data. The data that goes into your spreadsheet needs to be 

complete and accurate to give the correct results.

Use shortcut menus (by right-clicking the mouse button) to bring up quick commands. Use 

shortcut keys to undertake actions quickly (e.g. use Ctrl+X to cut and Ctrl+V to paste). 
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Familiarise yourself with the tools available in the ribbons and the groups of tools under 

each tab. If you think there should be an easier way of doing something, there probably is. 

Remember, you can always search the Excel help facility for assistance.

Use the numeric keypad on your keyboard to enter data, and try to improve your typing 

speed and accuracy for text-based entries.

Checking and proofreading data 

If you are working under tight deadlines, it is easy to make mistakes, such as subtracting 

one cell from another instead of adding them. 

Proofreading is the process of carefully reviewing a document for any mistakes. To 

proofread a spreadsheet, you need to check for correct layout, ensuring consistent styles 

have been used, that the information is clear and easy to read, and the data is accurate.

To check values, compare the values you have entered with the values you were given. 

Make sure that you have not made any errors when copying values and that you have 

entered all the data in the correct places.

To check errors in labels, you can use the Spelling function under the  

Review tab. 

This will pick up words you have misspelt, but it will not help you with 

product names or customer names and addresses, so you will need to 

check these carefully. 

Practice Task 16
Read the case study, then answer the questions that follow.

Case study

Crystal works as an administrative o$icer for a local government agency’s conference and meeting 

centre. Her role involves coordinating the bookings for the centre, as well as maintaining an 

adequate supply of stock and resources for the centre’s clients. Crystal’s supervisor has asked her 

to produce a report by the end of the day summarising all the clients that have used the centre 

in the past 12 months, along with a chart that shows the percentage of their usage. Crystal went 

about her daily tasks as usual. She allowed herself the last hour of the day to prepare the report 

and chart. When Crystal began preparing the report and chart, she realised that it was a much 

bigger job than she had anticipated. Crystal realised she needed a lot more time to compile the 

information for her supervisor.
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Question 1

What should Crystal do?

Question 2

What could Crystal have done di$erently when agreeing to the deadline for the task?

Question 3

How important is the data-gathering component of this task?
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Question 4

What does the task actually require Crystal to do? 
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4B Printing spreadsheets 
 

A workplace normally has standards for sta# to adhere to when printing. 

An organisation may require you to follow guidelines regarding printing and paper use. 

For example, you may be expected to use recycled paper when printing drafts. Using 

print preview to proof spreadsheets before printing can help to save paper.

Organisational and task requirements may specify things like the number of copies you 

should print, and whether colour printing is permitted. 

When preparing to print spreadsheets, ask yourself the following questions:

• What do I need to print – workbook, active spreadsheet, selected data or chart?

• Did I preview before printing?

• If it is a draft spreadsheet, should I print on recycled paper?

• How many copies of the spreadsheet do I need?

Print preview 

Print previewing lets you check spreadsheet accuracy, layout, presentation, 

consistency and readability. 

Part of the proo+ng process for +nalising spreadsheets and charts is to preview them 

before printing. Print preview lets you check that the requirements originally speci+ed 

have been met and allows you to check layout and overall appearance.

To preview your spreadsheet or chart, go to the File tab and select Print. The preview 

will be visible in the right-hand side.
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If you have selected the chart object, only the chart will be displayed in print preview, not 

the data. Excel assumes that if you have selected the chart, that is all you want to print. If 

you want to preview both the data and the chart, ensure the worksheet is active and not 

just the chart.

If the chart is a separate sheet in the workbook and not an object with data, to preview 

the chart you will need to select the worksheet that it is contained in.

The default option for print preview is to preview only the current worksheet in view. If 

you want to view the entire workbook, you need to select all worksheets. To do this, hold 

down the Ctrl key and click on each worksheet before viewing print preview.

Be careful if you are selecting multiple worksheets. If you have a number of worksheets 

active at one time, any data that you alter and input will be repeated on all of the selected 

worksheets. To deactivate multiple selected worksheets, simply click on one worksheet, 

which will become the active worksheet.

Print tools

There are a number of tools you can access and apply before printing your spreadsheet.

To access these options, select File, then the Print tab. Here you can do the following:

• print the workbook, spreadsheet or selected object

• enter the number of copies you want to print 

• select double-sided printing

• alter the orientation from portrait to landscape
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• choose the paper size

• adjust margins and scaling.

Further page setup options are available by clicking on the link below the Scaling drop-

down menu.

Below print preview there are buttons that allow you to:

• view next and previous pages

• zoom in or out on the spreadsheet

• show margins of the document and, if needed, make manual adjustments using 

your mouse.

The +rst drop-down menu under Settings identi+es what is to be printed and will show 

active sheets. From the drop-down menu you can choose to print the entire workbook or 

a selection of cells. 

From Page Setup you can adjust the scaling. 

Scaling allows you to adjust the size of the 

printout, making it larger or smaller on the 

printed page.

Alter the printer that you are printing to if 

needed, and select how many copies you want 

to print. It is also possible to alter how the 

multiple printed copies are collated. 

You can adjust the size of the printout by 

altering Adjust to more than 100 per cent of 

normal size in the Page Setup dialog box. 



114 Unit Release 1 (Aspire version 1.1) © Aspire Training & Consulting

BSBTEC302   |   Design and produce spreadsheets

Printing a selection from a workbook

You may be dealing with a very large worksheet or your manager may have requested 

only some information from a worksheet. If this occurs, you may need to print only part 

of a worksheet. To do this, select the cells you wish to print. From the File tab select the 

Print tab. From the +rst drop-down menu under settings choose Print Selection. Click 

the Print button.

If you want to print formulas entered in a worksheet, go to the Formulas tab and select 

Show Formulas from the Formula Auditing section.

When in print preview, go to Page Setup and select Fit to +t your worksheets on one 

page or on a number of pages.

To print an entire workbook comprising multiple worksheets, follow the instructions for 

printing a selection, but from the drop-down menu, select Print Entire Workbook.

Practice Task 17
Open the file Hemline Miller January report.

1. Preview the spreadsheet. Check the 

appearance of the data and charts, and 

make any necessary adjustments before 

printing. Print one copy of the spreadsheet.

2. Select cells A4 to B9 – this will select only 

the store and sales data. Print only the 

selected data.

3. Select the column chart and select File, 

then Print. Notice that Print Selected 

Chart is automatically selected. Alter the 

printer that you are printing to if needed, 

and select how many copies of the chart 

you want to print. Click the Print button. 

4. Print out the Store and Sales columns. 

Adjust the size of your selection until it  

is 150 per cent of normal size.
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4C Naming and storing spreadsheets 
appropriately

You need to follow any requirements of your organisation for naming and storing 

spreadsheet files. 

This will make it easier for you and your colleagues to retrieve spreadsheets when 

needed. Some organisations have strict naming standards that must be adhered to,  

such as all project +les having to start with ‘PRO’. Another example is using product 

codes rather than descriptions. It is better to use a product code as this is individual, 

whereas there may be many products with similar descriptions, so it can become 

confusing. Find out the naming standards for folders and +les in your workplace.

When you have a spreadsheet stored in a folder, it must have a unique name. No two 

spreadsheets stored in the same location can have the same name. Excel will let you 

know if a +le with the same name already exists, and you will have to save the +le 

using an alternative name. If you are not sure of the procedures for saving and storing 

spreadsheets, ask your supervisor.

When closing Excel, always follow procedures and exit the program correctly. This ensures 

the data you have entered into the spreadsheet does not become corrupted the next time 

the spreadsheet is used.

Naming spreadsheets

As well as placing folders and +les in the appropriate locations, you also need to give 

them appropriate names. Naming conventions need to be kept consistent, simple and 

meaningful. The +le name you choose may include any combination of numbers or 

letters. Some characters cannot be used in +lenames, including: . , / \ * ? <. Appropriate 

naming conventions help people identify and retrieve +les.

When saving, Excel automatically adds a +le extension to your spreadsheet. The +le 

extension identi+es the type of program that the spreadsheet has been created in, and 

tells your computer system what program to use when opening the +le again. In Excel 

2016, all spreadsheets are saved with the extension .xlsx. For much earlier versions of 

Excel (1997 to 2003), the extension is .xls.

Excel 2016 has some features that are not available in previous versions. If you are 

creating a spreadsheet that others need to access electronically with a version older than 

Excel 2007, you will need to work in compatibility mode. Compatibility mode turns o4 

some of the new features, which ensures that people working in older versions will have 

full editing capabilities.
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To save a spreadsheet in compatibility mode, go to the File tab, select Save As, and select 

Excel 97–2003 Workbook in the Save As Type list. 

Storage security

Security measures such as usernames and passwords allow users di#erent 

levels of access to files on an organisation’s server.

Information is a valuable asset in any organisation. How information is stored and the 

security measures used to protect it are central to an organisation’s procedures.

The spreadsheets you create will usually be stored on a server that allows access to 

multiple users. A server delivers information and software to other computers linked by a 

network.

To enable sta4 to log on to a server, the systems administrator will issue each person 

with a username. The user must then create a password. Usernames and passwords:

• give users access to the information they require to complete workplace tasks

• allow users to have di4erent levels of access to information.

You may +nd that some of the spreadsheets you work with are con+dential. Ask your 

manager for your organisation’s policies regarding con+dential material.

Authorised access

Many organisations have protocols in place where you can only access those parts of the 

shared network that are relevant to your work or your department. 

Authority to access various parts of the shared network are provided by the 

organisation’s systems administrator. If you do not have access to a part of the shared 

network that you need access to, discuss this with your manager.

It is also possible to limit access to spreadsheets that you create by using passwords. 

Passwords are commonly used for spreadsheets that contain con+dential, private or 

sensitive information, such as pro+t analysis and sta4 details. Passwords can be used to 

limit access to opening spreadsheets or to limit the ability to modify information in the 

spreadsheet. 

To place a password on a spreadsheet, open a spreadsheet and select the File tab. Under 

Info, select Protect Workbook, then select Encrypt with Password under the drop-

down menu.
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Type in a password (write down the password or ensure it is one you will easily 

remember) and click OK. Save your document. If an error message appears stating, ‘There 

is already a +le with that name existing, do you want to replace existing +le?’, select Yes. 

This will override the current +le and replace it with one with a password.

Close the spreadsheet and open it again to test that the password is working. 

Backing up and safeguarding data

Many organisations have set procedures for backing up +les. 

Backing up +les is an important practice as it helps to prevent the loss of documents  

and information, and is extremely useful if something happens to the network or 

computer system as you will be able to retrieve previous documents.

In many large organisations this is administered through the IT department and is an 

automatic process. In this case, the only thing you need to do is save your +les to the 

appropriate network drive and folders.

In smaller organisations, it may be necessary for you to back up +les to an external 

network or drive. This may be done on a daily or weekly basis. Check with your 

supervisor for the relevant backup procedures.

USB sticks are useful for storing and backing up information, especially when you require 

a portable copy of the information.

Data also needs to be safeguarded against accidental or deliberate damage. 

Data loss is usually caused by human error or system failure. Many organisations use  

a data cartridge or cloud-based storage to back up information on a database. 

A server is made up of many +les and folders. Organising this information helps users 

+nd what they want. If you are saving information onto a server, make sure you know 

where to put it. Save your work frequently at various stages through the production 

process. Ask about your organisation’s policies regarding the storage and security of 

spreadsheet +les. 

Policies for filing hard copies of spreadsheets

It is common for spreadsheets stored digitally to also be stored in hard copy. 

This guards against a computer system failure. Hard-copy storage requires space and 

the establishment of a +ling system that uses consistent, simple and meaningful names, 

similar to digital storage.
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Hard-copy spreadsheets must be kept up to date. Physical storage needs to be managed 

well since storage space is often scarce and valuable. Old or superseded spreadsheets 

should be destroyed on a regular basis. Retention schedules list the timeframes that 

spreadsheets need to be kept before they can be destroyed. Spreadsheets without 

permanent value may be scheduled for eventual destruction. Find out what kind of hard-

copy +ling system is used at your workplace; ask your supervisor if you are unsure.

Exiting the application safely

After creating or modifying a spreadsheet, you need to exit the software application 

without causing damage or data loss. 

Data loss occurs when a computer program stops performing its expected function. 

Often the program or even the whole computer may appear to freeze. All computer 

users will experience data loss at some time. Data may have been accidentally erased or 

corrupted and made inaccessible.

To exit the spreadsheet program, click the Exit button, which is located in the top right 

corner of the window. If you have recently made changes to your spreadsheet, you will be 

prompted to save your document.

Precautions to prevent data loss

• Try to work on only one spreadsheet at a time.

• Data loss can occur if someone else tampers with your work. If you are working on a 

spreadsheet at your workstation, lock your computer or exit the application before leaving 

your workstation unattended.

• If you need to work with multiple applications open, make sure you close applications that 

are no longer needed. This will help your computer work more quickly and will prevent data 

loss in the event of computer failure.

• If your computer starts to behave in an unusual way, save your work and shut it down 

immediately, and do not turn it back on until you get assistance.

• Make sure your computer has up-to-date antivirus, antispyware and firewall programs 

to protect it against malware from the internet. Also check that it has the latest security 

updates.
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Practice Task 18

Part A
Read the first case study, then answer the questions that follow.

Case study

Matthew works as an o$ice administrator in a large organisation. His duties include formatting 

reports and saving them on the server. He is also responsible for backing up the server at the end 

of each day. 

At the end of a busy day, Matthew has completed several reports for di$erent departments in the 

organisation. He saved each of them in a di$erent location, and it took him a while to work out 

where they all belonged. He was not sure if he saved them all in the correct place. After this, he was 

running late and decided not to back up the server. 

The next morning, the reports that Matthew had saved were needed for an important board 

meeting. However, during the night a virus had infected the server, destroying all the information 

from the previous day.

Question 1

What would be the consequences if Matthew did not save some of the reports in the correct 

place?

Question 2

Can you think of any consequences of not backing up data on the server?
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Part B
Read the second case study, then answer the questions that follow.

Case study 

Fred has retired from an organisation after working as an administrative assistant for 10 years. The 

areas Fred was responsible for were accounts and projects. The day after he retired, someone 

needed a file that Fred had created and stored. The file contained vital accounting information. It 

was discovered that Fred had saved more than 500 files in a variety of folders and the file could 

not be located. The folders had ambiguous names such as ‘Folder1’ and ‘Folder2’ and the files had 

names such as ‘august1’ and ‘march2’.

Question 1

Describe why Fred’s folder and file naming system failed.

Question 2

Fred was responsible for two areas. What could he have done to make sure files could be easily 

located?
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Question 3

Explain why folder and file names should be consistent, simple and meaningful.

Summary

• Make sure you have formatted, checked all formulas and functions and proofread 

your spreadsheet before printing.

• Working within a designated timeline means you must plan your work.

• Collecting, checking and entering data can be a big part of the task.

• You should always preview your work before printing.

• It is possible to print a whole spreadsheet or parts of a spreadsheet. 

• A chart can be printed on its own or as part of a worksheet.

• You need to understand your organisation’s policies and procedures for saving 

and storing spreadsheets.

• You may need to restrict access to sensitive information by setting a password.

• It is important to safeguard and back up +les.
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Learning Checkpoint 4

Finalise and present spreadsheets

Part A
1. Using the data below, create a professionally presented spreadsheet and appropriate chart  

to compare daily rainfall each year.

Rainfall in millimetres

2017 2018

1 January 23 34

2 January 25 41

3 January 34 42

4 January 37 20

5 January 42 23

6 January 19 24

7 January 20 33

2. Print your spreadsheet on one page – landscape page orientation, incorporating the chart  

as an object of the spreadsheet.

3. Save the spreadsheet to an appropriate location and name it ‘Daily-rainfall’.

4. Use the checklist below to ensure that you adhered to requirements for finalising your 

spreadsheet.

Task What to check for 

Data entry • Accuracy of data input 

Data formatting • Formatted professionally – appropriate use of styles, colour, 

font type, font size, bold, italic, underline, borders, shading, 

alignment, etc.



Chart • Chart inserted as an object

• Selected chart meets analysis requirements

• Formatted professionally – appropriate use of layout and 

styles, colour, labels, titles, borders



Save file • Saved as ‘Daily-rainfall’

• Saved to appropriate file location – drive and folder


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Task What to check for 

Print preview • Print preview used to check data, layout and overall 

presentation

• Any required adjustments to content, layout, appearance 

made



Print • Printed single page to selected printer

• Printed in landscape orientation

• Spreadsheet data and chart on same page



Exit Excel • Exited Excel ensuring all work is saved appropriately 

Adhere to task 

requirements

• Followed instructions 

• End result: One-page printout – spreadsheet data and chart, 

professionally presented



Meet designated 

timelines

• Able to meet designated timeline 

• Negotiated extension to timeline if needed



Part B
1. What can you do to improve your speed and accuracy when working with spreadsheets?

2. Why is it good practice to preview before you print the final spreadsheet?
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3. What tools and systems should you use to ensure that you meet timelines?

4. How can you name and store your spreadsheets to ensure easy access in the future?

5. What can you do to prevent loss or damage to your spreadsheets?
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Part C
Use the following data to create a professionally presented spreadsheet and chart that compares 

target stock supply with actual stock supply.

Save the spreadsheet to an appropriate location and name it ‘January stock supply’.

Our O2ice 2 U – January stock supply

Target vs actual

Product code Target Actual Percentage of target  
that was achieved

PC239 4000 4309

PC340 3000 2987

PC401 2500 1076

PC509 4300 4109

PC617 3800 4026

Include the following components in your spreadsheet:

• Footer stating the file reference details

• Chart legend, chart title and axis titles

• Blue, Arial,10-point font

Make other appropriate formatting choices to ensure the spreadsheet and chart are professionally 

presented, such as a landscape orientation and centring the spreadsheet on the page – horizontally 

and vertically.

Make sure you:

• preview before printing – print the spreadsheet and chart on separate pages

• save to an appropriate location and name the spreadsheet ‘January-stock-supply’

• exit the program ensuring that all files have been saved as appropriate.
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